
LigandScout User Manual



LigandScout User Manual



iii

Table of Contents
1. Introduction to LigandScout ....................................................................................  5

1.1. What's New in LigandScout 3.0? ..................................................................  6
1.2. Installing and Starting LigandScout ...............................................................  7
1.3. Visual Semantics .........................................................................................  8
1.4. LigandScout Graphical User Interface ...........................................................  9

2. File Handling, Data Management and Networking ..................................................  11
2.1. Importing and Exporting Files .....................................................................  11
2.2. Retrieving PDB Complexes Online .............................................................. 15
2.3. Local and Shared Repository .....................................................................  16

2.3.1. Handling the Repository ..................................................................  17
2.4. Sessions ...................................................................................................  17

2.4.1. Handling Sessions ..........................................................................  18
2.5. Networking ................................................................................................  19

2.5.1. iworker ...........................................................................................  19
2.5.2. Network Monitor .............................................................................. 21

3. LigandScout Perspectives .....................................................................................  24
3.1. Basic User Interface Modules .....................................................................  25

3.1.1. 3D View .........................................................................................  25
3.1.2. 2D View .........................................................................................  28
3.1.3. 3D Widgets ....................................................................................  29
3.1.4. Hierarchy View ...............................................................................  30
3.1.5. Library View ...................................................................................  31

3.2. Structure-Based Modeling Perspective ........................................................  33
3.2.1. PDB View ....................................................................................... 34
3.2.2. Bookmark View ............................................................................... 38

3.3. Ligand-Based Modeling Perspective ...........................................................  40
3.3.1. Importing Ligands ...........................................................................  40
3.3.2. Navigation and Working with the Tool Bar ........................................  41
3.3.3. Biasing Pharmacophore Generation .................................................  42

3.4. Alignment Perspective ...............................................................................  44
3.4.1. Alignment Panel .............................................................................. 44

3.5. Screening Perspective ...............................................................................  48
3.5.1. Screening Panel .............................................................................  48
3.5.2. Library View ...................................................................................  50

4. Introduction to Pharmacophore Modeling ...............................................................  51
4.1. Pharmacophore Modeling ........................................................................... 51

4.1.1. Pharmacophore Definition ................................................................ 51
4.2. Pharmacophore Feature Definitions ............................................................  52

4.2.1. Pharmacophore Feature Constraint Types ........................................  53
4.2.2. Pharmacophore Feature Definitions .................................................  54

4.3. Editing a Pharmacophore Model .................................................................  56
5. Structure-Based Pharmacophore Design ...............................................................  58

5.1. Structure-Based Pharmacophores ............................................................... 58
5.1.1. Why Use Structure-Based Pharmacophores? .................................... 58
5.1.2. Basic Workflow ...............................................................................  59

5.2. Creating Structure-Based Pharmacophores .................................................  60
5.2.1. Data Import and Structure Preparation .............................................  60
5.2.2. Automated Generation of Structure-Based Pharmacophores ..............  60

6. Pharmacophore Alignment ....................................................................................  62
6.1. Aligning Pharmacophores and Molecules ....................................................  62

6.1.1. Aligning Pharmacophores and Molecules by Features .......................  62
6.1.2. Aligning Pharmacophores and Molecules by Reference Points ...........  64

6.2. Shared Feature Pharmacophore .................................................................  65
6.2.1. Creating a Shared Feature Pharmacophore ......................................  65

6.3. Merged Feature Pharmacophore ................................................................  66



LigandScout User Manual

iv

6.3.1. Automatically Merge Pharmacophores .............................................. 66
6.3.2. Manually Merge Pharmacophores ....................................................  67
6.3.3. Combine Features in One Pharmacophore .......................................  68

7. Ligand-Based Pharmacophore Design ...................................................................  69
7.1. Ligand-Based Pharmacophores ..................................................................  69

7.1.1. Why Use Ligand-Based Pharmacophores? .......................................  69
7.1.2. Basic Workflow ...............................................................................  70

7.2. Creating Ligand-Based Pharmacophores ....................................................  71
7.2.1. Define and prepare Ligand-Set ........................................................  71
7.2.2. Performing Ligand-Based Pharmacophore Creation ........................... 72
7.2.3. Resulting Ligand-based Pharmacophore Models ...............................  73

8. Virtual Screening ..................................................................................................  74
8.1. Virtual Screening in LigandScout ................................................................  74

8.1.1. Pharmacophore and Molecule Library Preparation ............................. 74
8.1.2. Run Virtual Screening .....................................................................  75
8.1.3. Screening Results ...........................................................................  75

8.2. Preparing a Pharmacophore for Virtual Screening with External Applications
.........................................................................................................................  76

9. LigandScout Settings: Preferences ........................................................................  82
9.1. Structure-Based Modeling Settings .............................................................  83

9.1.1. PDB Interpretation ..........................................................................  83
9.1.2. Distance Ranges ............................................................................  84
9.1.3. Hydrogen Bonding ..........................................................................  85
9.1.4. Metal Binding .................................................................................. 85
9.1.5. Hydrophobicity ................................................................................  86
9.1.6. Aromatic Interactions ....................................................................... 86

9.2. Ligand-Based Modeling Settings ................................................................. 87
9.2.1. Settings and Scoring .......................................................................  87
9.2.2. Conformer Generation .....................................................................  88
9.2.3. Clustering .......................................................................................  90

9.3. Chemistry Settings ..................................................................................... 90
9.3.1. Tautomerization ..............................................................................  90
9.3.2. Tautomer Filters .............................................................................. 92
9.3.3. Force Field: MMFF94 ......................................................................  92
9.3.4. Force Field: Minimization .................................................................  94

9.4. Library Screening Settings .........................................................................  96
9.5. Alignment Settings .....................................................................................  96

9.5.1. Alignment .......................................................................................  97
9.6. Rendering Settings ....................................................................................  98

9.6.1. 3D General Settings ........................................................................ 98
9.6.2. 3D Renderer Style ........................................................................  100
9.6.3. 2D Depiction .................................................................................  101

9.7. Program and Network Settings .................................................................  102
9.7.1. Main Settings ................................................................................  102
9.7.2. PDB and Proxy .............................................................................  102
9.7.3. Distributed Calculation ...................................................................  103

A. Appendix ...........................................................................................................  105
A.1. LigandScout Menu Reference ..................................................................  105
A.2. LigandScout Icons Reference ................................................................... 126
A.3. LigandScout Keyboard Shortcuts ..............................................................  129
A.4. LigandScout Mouse Bindings ...................................................................  131
A.5. Command Line Usage .............................................................................  132
A.6. Scoring Function .....................................................................................  137
A.7. Primary Literature ....................................................................................  139

Index .....................................................................................................................  142



5

Chapter 1. Introduction to
LigandScout
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LigandScout is a powerful structure- and ligand-based pharmacophore model generator based on

sophisticated algorithms for performing alignments and interpreting and customizing ligand-macro-

molecule interactions.

LigandScout extracts and interprets ligands and their macromolecular environment from PDB files and

automatically creates and visualizes advanced 3D pharmacophore models supporting multiple features

per heavy atom to broaden the scope of a single model. A wide range of powerful editing tools (2D

View and 3D View) lets you generate customized, highly specific pharmacophore models within a few

seconds. Excluded volume recognition and the resulting excluded volume coats drastically increase

selectivity by considering sterical characteristics of the binding site. Moreover, LigandScout supports

the generation of pharmacophore models based on molecules injected into the binding site and supplies

a Library View for the investigation of docking poses and viewing results of virtual screening in the active

site.

Analysis of the conformational space of ligands, clustering and alignment methods help to search for

common feature arrangements. This is especially useful when binding site interactions are not known.

Reaching a consensus pattern from a set of ligands binding to one particular macromolecule is a further

step in drug development. Rapid and accurate in-silico screening of compound libraries is integrated

into LigandScout along with tools to analyze the performance of the models.

This manual documents all LigandScout features and gives workflow guidelines for the generation of

structure-based pharmacophores, ligand-based pharmacophores, virtual screening of molecule libraries

and pharmacophore preparation for external virtual screening applications.

Next steps:

1. What's New in LigandScout 3.0

2. Installing and Starting LigandScout

3. Visual Semantics

4. Using LigandScout: The 3D Graphical User Interface
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1.1. What's New in LigandScout 3.0?
New features introduced to LigandScout 3.0:

1. Ligand-Based Modeling

2. Virtual Screening

3. Conformation Generation

4. Conformational Clustering

5. Tautomer Generation

6. Molecule Structure Optimization by MMF94 Force Fields

7. Fast Calculation of Tasks through the Network to increase Execution Performance

1.1.1. Hot Topics

Tautomers

Tautomeric rearrangements of a molecule lead to distinct equilibrated structural states of the same

chemical compound and thus have an influence on nearly all aspects of computer-based chemical data

processing. Especially for structure-based pharmacophore modeling of ligand-protein complexes, tau-

tomeric rearrangements are crucial for the presence or absence of possible H-bonding interactions due

to changing H-donor/H-acceptor properties. LigandScout provides a rule-based ligand-side tautomer

enumeration and ranking procedure that considers both geometrical constraints imposed by the confor-

mation of the bound ligand as well as intra- and inter-molecular energetic contributions.

Force Fields

LigandScout provides a full fledged, test-suite conforming MMFF94 implementation for the energy cal-

culation and geometry optimization of molecular structures. You can calculate the strain energy of com-

pounds in a database, energy-minimize the structure of free molecules or optimize ligands within a

binding pocket. The parameters of the MMFF94 force field can be customized. For instance, you can

define which components of the force field have to be considered and specify parameters for several

interactions (e.g. distance cutoffs for Van der Waals and electrostatic interactions). During a structure

optimization process, SMARTS pattern defined parts of the ligand or molecular environment can be

kept fixed.

Conformation Analysis

The “right” ligand conformation is a prerequisite for an energetically favorable interaction with the target

receptor. Thus, consideration of multiple ligand conformations can increase significantly the quality and

reliability of derived pharmacophore models. LigandScout enables the creation of ligand-based phar-
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macophores from single and multiple ligand conformations. Conformations are generated by OMEGA

which can be customized freely to yield optimal results.

Clustering

One of the crucial parts of ligand-based pharmacophore creation is the choice of ligands for the Train-

ing-Set and Test-Set. LigandScout offers clustering methods to assist your decision. This functionality

groups ligands according to their similarity to each other using distance calculation methods.

1.2. Installing and Starting LigandScout
The current version of LigandScout is available via Internet download from Inte:Ligand [http://

www.inteligand.com/ligandscout/download.shtml]. The LigandScout setup assistant will guide you

through the installation process. Follow the instructions of the setup assistant to finish the installation;

LigandScout is now ready to use.

Figure 1.1. LigandScout installer

Click on the LigandScout icon (at the location selected during the installation process) to start the ap-

plication.

Upon the startup of LigandScout you will be prompted for the serial number, which was shipped together

with your LigandScout program package. You will then need to activate your copy of LigandScout, which

requires an established Internet connection. This activation procedure needs to be executed only once.

You may use your copy of LigandScout at your convenience during the entire license period.

Please see Section 2.3, “Local and Shared Repository”, if you would like to install a data repository.

http://www.inteligand.com/ligandscout/download.shtml
http://www.inteligand.com/ligandscout/download.shtml
http://www.inteligand.com/ligandscout/download.shtml
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1.3. Visual Semantics
The overview below demonstrates the basic concept for the icons and symbols in LigandScout. It pro-

vides quick recognition for the meaning of the program controls.

Chemical feature

Multiple chemical features form a pharmacophore and are responsible for

steric and functional chemical interactions between macromolecules and

ligands. Chemical features always refer to the ligand side, but take the

macromolecule geometry into account in many cases (e.g. hydrogen bond

vectors, where the vector target points to the macromolecule counterpart).

Active Site

Represents the binding pocket in the macromolecule. It consists of a core

(ligand molecule), an environment (surrounding residues of binding pock-

et) and potential chemical features.

Core

The ligand molecule without the surrounding standard residues (amino

acids or nucleic acids).

Environment

The environment includes all macromolecule components (amino acids

or nucleic acids) that LigandScout considers to be relevant for phar-

macophore generation and thus biological interaction. A structure-based

pharmacophore is always created based on interactions between core

and environment. Molecules, such as co-factors, waters and ions can be

moved between the two sides allowing different views of interactions to be

reflected for pharmacophore generation. A ligand-based pharmacophore

is generated considering only features of a ligand (set).

Pharmacophore

A pharmacophore is the set of chemical and steric interactions between a

ligand and macromolecule that are relevant to trigger biological response.

Excluded Volume Spheres

Excluded volumes indicate areas which are sterically forbidden for the

ligand (e.g. because of the presence of the protein backbone or a lipophilic

interaction).

Atom
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Bond

Molecule

1.4. LigandScout Graphical User Interface
LigandScout uses an intuitive graphical user interface (GUI) for sophisticated pharmacophore genera-

tion and data analysis. It provides five perspectives, which have different functionalities:

1. Structure-Based Modeling Perspective
Analysis of ligand-macromolecule interactions. Viewing and calculating properties of
molecule libraries in the PDB View. Managing binding sites in the Bookmark View.

2. Ligand-Based Modeling Perspective
Analysis of common interaction patterns of a set of ligands.

3. Alignment Perspective
Aligning of pharmacophore model(s) and/or molecule(s).

4. Screening Perspective
Screening molecule libraries using pharmacophores.

Figure 1.2. Graphical user interface
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The Figure 1.2, “Graphical user interface” shows the Structure-Based Modeling Perspective of Ligand-

Scout. LigandScout contains a menu, toolbar, five perspectives and control panels (in this case, the PDB

Panel is shown). Furthermore, LigandScout provides modules such as interactive 2D and 3D visualiza-

tion areas, Library View and Hierarchy View, which help to orientate and navigate through your data.

The visibility of the control panels, 2D View and Hierarchy View can be toggled in the Window menu.

LigandScout provides universal Undo and Redo functionality that lets you go back and forth in history.

For more information about the five perspectives please see Chapter 3, LigandScout Perspectives.
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Chapter 2. File Handling, Data
Management and Networking
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2.5.2. Network Monitor ...................................................................................... 21

Investigation of molecular information produces a lot of data - especially if you work on diverse projects,

e.g. data from PDB complexes, molecule and/or pharmacophore alignments, molecule libraries, screen-

ing results, etc. LigandScout offers various ways to keep an overview and organize your data.

1. Importing and Exporting Files

2. Retrieving PDB Complexes Online

3. Local and Shared Repository

4. Sessions

In terms of data management it is important to efficiently store your data - especially when dealing

with large data amounts. On the other hand it is equally important to efficiently process your data. For

instance, a single computer running a single task that screens a multi-conformational molecule database

can be very time-consuming. One way to deal with this situation is to make use of multi-core processors.

Another way to reduce the overall execution time is to setup a network of remote peers, each one

performing a piece of work. LigandScout does support this kind of network execution. Please, refer to

Section 2.5, “Networking” which discusses this topic in detail.

2.1. Importing and Exporting Files
LigandScout supports commonly used file formats as well as its own file formats to exchange informa-

tion. As the main focus of LigandScout is drug development and pharmacophore modeling, all file for-

mats either deal with molecular data, pharmacophore models, or display-related information.
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2.1.1. Importing Files

The File menu provides two possibilities to import data: the Open command (CTRL+O) and the Insert

command (CTRL+I). Both trigger the display of the file dialog that facilitates the import of files that are

being loaded into the current view, whereas the former clears the view first.

Figure 2.1. Open file dialog

The supported import file formats can be differentiated into LigandScout, molecule and other file formats.

The following table gives an overview of the file formats including name and file extension list.

File Format Name Extension(s)

LigandScout Library in Local Database .ldb

 Ligand Set Description .lsd

 Pharmaceutical Markup Language .pml

 Compressed Pharmaceutical Markup Language .pmz

 Session .ses

Molecule MDL Molfile .mol

 Tripos Sybyl MOL2 Molecule .mol2

 MDL Structure-Data .sd .sdf

 GZip Compressed MDL Structure-Data .sd.gz .sdf.gz

 Zip Compressed MDL Structure-Data .sd.zip .sdf.zip

 Daylight Chemical SMILES String .smi

Other Protein Data Bank (PDB) .pdb .ent

 GZip Compressed Protein Data Bank (PDB) .pdb.gz .ent.gz

 Zip Compressed Protein Data Bank (PDB) .pdb.zip .ent.zip

 Molecular Discovery GRID .kont

Table 2.1. Supported import file formats

The PDB file format provides 3D information about the macromolecule from X-ray or NMR sources. This

data plays an important role in deriving a pharmacophore model representing the bound state of a ligand

inside a protein binding pocket. The Molfile characterizes a single molecular structure whereas SD(F)

and MOL2 files can store more than one molecule (molecule library). In LigandScout, a single molecule



File Handling, Data Management and Networking

13

can be used to create a pharmacophore model or to align to other molecules/pharmacophores. The

latter allows LigandScout to import compound collections. For instance investigations of these ligands

with respect to their protein environment, and also for generating pharmacophores based on docking

poses. Moreover, LigandScout can filter molecules from a molecule library that fulfill a desired pharma-

cophoric pattern. Compared to the other file formats, SMILES files represent only the 2D depiction of the

molecules. The 2D View of LigandScout uses the 2D information of the ligand to visualize the derived

pharmacophoric features.

The PML file format can be stored and opened with different combinations of content elements, for in-

stance a pharmacophore of a ligand-protein complex or alignments of molecules. The PMZ format con-

tains the compressed PML data. The LSD file format is used in the Ligand-Based Modeling Perspective

to generate pharmacophores from a set of ligands. The LDB file format are used to store/load molecule

libraries. This can be useful for investigations of compounds with respect to their protein environment,

and also for generating pharmacophores based on docking poses. For more information on advanced

export settings, see also the section called “Advanced Export Settings”.

The GRID Map file format can be imported to LigandScout to analyze energetically favorable regions

in the binding pocket of a protein. For more information about this topic, please see the section called

“GRID Maps Visualization”.

2.1.2. Exporting Files

LigandScout supports data export in several chemical and graphical file formats. Use the command

(CTRL+SHIFT+S) in the menu File > Save as File which enables you to save your macromolecule, ligand

modifications, and pharmacophore models. A session can be stored in the menu File > Sessions > Save

as File. Depending on the selected file format and content, the Save File  dialog provides advanced

export settings.

Figure 2.2. Save file dialog

The following table gives you a summary of the supported export file formats together with which data

of your work that can be exported in a particular format. Each format facilitates the export of certain
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information: molecules (M), ligand environment (E), pharmacophore models (P), and the current content

of either 3D View or 2D View (V).

File Format Name Extension(s) M E P V

LigandScout Compressed Pharmaceutical Markup
Language

.pmz
x x x  

 Pharmaceutical Markup Language .pml x x x  

 Ligand Set Description .lsd x  x  

 Library in Local Database .ldb x    

 Session .ses x x x  

Molecule Daylight Chemical Smiles String .smi x    

 MDL Structure-Data .sd .sdf x    

 GZip Compressed MDL Struc-
ture-Data

.sd.gz .sdf.gz
x    

 Zip Compressed MDL Structure-Data .sd.zip .sdf.zip x    

 Maestro Molecule .mae x    

 MDL Molfile .mol x    

 Tripos Sybyl MOL2 Molecule .mol2 x    

Pharmacophore Catalyst Hypoedit Script .hypoedit   x  

 Fred 2 Constraint Map .fred2map   x  

 Phase Files .xyz .xvol .def .mae   x  

 CCG MOE Format .ph4   x  

Image Encapsulated PostScript .eps    x

 Graphics Interchange Format .gif    x

 Joint Photographers Expert Group
Format

.jpg
   x

 MacroMedia Flash File Format .swf    x

 POV-Ray Scene Desription .pov    x

 Portable Document Format .pdf    x

 Portable Network Graphics Format .png    x

 PostScript .ps    x

 RAW Image .raw    x

 Scalable Vector Graphics .svg    x

 GZip Compressed Scalable Vector
Graphics

.svgz
   x

 UNIX Portable PixMap .ppm    x

 Windows Enhanced Metafile .emf    x

Other Protein Data Bank (PDB) .pdb .ent x x   

 GZip Compressed Protein Data Bank
(PDB)

.pdb.gz .ent.gz
x x   

 Zip Compressed Protein Data Bank
(PDB)

.pdb.zip .ent.zip
x x   

Table 2.2. Supported export file formats
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Advanced Export Settings

LigandScout has its own file format, called PML. The advantage of this format is that the user can

select the available export content individually or in combination (ligand, environment, pharmacophore,

conformers, injected molecules, and tautomers).

LigandScout offers you the possibility to export LigandScout's pharmacophore models so that you can

use them in other external programs like Catalyst, MOE and Phase (see Section 8.2, “Preparing a

Pharmacophore for Virtual Screening with External Applications”).

You can save your content as PDB or ENT file format if you want to export the ligand, environment and

include hydrogen information. The SMILES string of molecules can also be exported as SMI files. You

can include in the files the canonical order of ligand atoms and/or stereo chemical properties. Single

molecules can be stored in mol files, as 2D or 3D data. Additionally, stereo-chemical properties can

be saved optionally.

The storage of a molecule library in LDB, MOL2 and SD(F) files can be customized. You can export

a Complete library or a part of it. A subset of a library can be chosen by filtering your library [33]

according to a property (e.g. by an occurring name), marking molecules or by visible molecules only. If

you want to export the properties of your library table, choose the Write properties option. The MOL2

and SD(F) file formats offer you the possibility to Write all conformations or Write 2D/3D coordinates of

the (selected) molecules in the library.

If you want to export currently displayed content as an image file (e.g. gif, svg, etc.) you can choose

between the 2D or 3D View. The 2D content can be saved as it is by the Keep current layout or you can

automatically store it as horizontal/vertical layout. After a screening run, you can export the ROC plot

as image. The image size can be set in both 2D and 3D.

2.2. Retrieving PDB Complexes Online
LigandScout provides the possibility to directly import PDB data from web sources specified in the

Preferences/PDB & Proxy Settings. Just type a valid PDB code into the PDB 4-letter code  field in the

control panel of the Structure-Based Modeling Perspective. If the data is available in either the Local

Repository or Shared Repository (Local and Shared Repository) then it is loaded immediately and the

button will be labeled Renew 'PDB code'. If the PDB complex was not found in the repositories the button

will be labeled Download 'PDB code'. Anyway, by clicking the button the PDB complex is loaded from

the web source, automatically interpreted, stored in the Local Repository, and displayed in LigandScout.
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Figure 2.3. PDB panel

LigandScout connects to the PDB servers listed in Preferences/PDB & Proxy Settings according to their

appearance. The listing of the servers from top to bottom is the order in which the servers are contacted

until a valid PDB structure is found and downloaded correctly or all listed servers were contacted. After

a successful download LigandScout activates the PDB interpretation algorithm, shows the complex in

the Macromolecule View, and stores a copy in the Local Repository automatically for faster access if

this code should be entered again sometime later. Please see Local and Shared Repository for detailed

information.

If you experience problems connecting to the PDB server(s), please see the PDB & Proxy Settings in

the Preferences/Program & Network Settings for more information.

2.3. Local and Shared Repository
LigandScout uses a “two-level” file storing strategy, the Shared Repository (or Central Repository) and

the Local Repository. If a PDB code is entered in the PDB 4-letter code field of the PDB Panel, Ligand-

Scout tries to find the associated files in the first level Local Repository. If unsuccessful, LigandScout

will check the Shared Repository which represents the second level. The Shared Repository is usually

installed at a central location and every licensee can take advantage of it by specifying the correct path

to this repository in Preferences/Program & Network Settings. As the second level repository is intended

to be shared among all licensed users, it is not modifiable using LigandScout (the only exception is if a

new repository is installed to be the new Shared Repository). Hence, there is the first level repository

which contains all of the changes that were performed on a structure locally (if the user decides to save

them). Also, recently downloaded and interpreted PDB structures will be stored there for faster retrieval

later on.
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2.3.1. Handling the Repository

Save to Repository

You can store changes to your current active site to the Local Repository with File > Save to Repository

(CTRL+S). If you do not use this command and you load new data or quit LigandScout, a Save changes

dialog reminds you to store or discard the modified data.

Importing a Repository

The  Import Repository command (CTRL+ALT+SHIFT+I) in the File > Repository menu allows you to

install a PDB repository.

Exporting a Repository

The Export Repository command (CTRL+ALT+SHIFT+E) in the File > Repository menu enables the

export of your PDB data storage. To allow sharing your Local and Shared Repository you can choose to

store it as a single compressed archive. Choose Local Repository for your local storage. If the repository

is located on a server and is to be shared with other users, select Shared Repository. Make sure that

you have writing privilege for this location. The path to your Shared Repository is specified in the Pref-

erences/Program & Network Settings whereas the Local Repository will be managed by LigandScout.

Clearing the Local Repository

The Clear Local Repository command (CTRL+ALT+SHIFT+C) in the File > Repository menu erases the

local PDB data storage. All changes and modifications will be lost if the Local Repository is cleared.

2.4. Sessions
Quite similar to the PDB data storage in the Local and Shared Repository LigandScout transparent-

ly stores information concerning the Local Repository, Alignment Perspective, Bookmark View, Lig-

and-Based Modeling Perspective and Screening Perspective. To be able to manage these data, espe-

cially when working on different projects with different data, it seems to be useful to backup your currrent

workspace as an individual session. Then you can load a different session or proceed modeling without

altering the stored session.
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2.4.1. Handling Sessions

Store current session

The current session can be stored in a SES file or directly in LigandScout. Choose in the menu bar File

> Sessions > Save Session as File or alternatively, File > Sessions > Save Current Session to save your

current data in a session by specifying a name. The latter stores the data in the .inteligand-data

directory.

Figure 2.4. Save Current Session

Remove session

If you want to remove a specific session go to File > Sessions menu. A list of available sessions appears

in the Managing Sessions dialog where you can delete a session of your choice.

Figure 2.5. Managing sessions

Restore a session

You can load a previously exported session file through the menu File > Sessions > Load Session

from File. Alternatively, choose a session from a list of available sessions provided in the Sessions
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submenu. Note that the new session replaces the current one. Thus, all of your current data from the

Local Repository, Ligand-Based Modeling Perspective, Alignment Perspective, Bookmark View and

Screening Perspective will be getting lost.

2.5. Networking
Computational chemistry is a field where the execution of tasks can take a lot of time. Especially if

huge molecule databases are used: e.g., to generate conformations or screen them against target

pharmacophore(s), getting the results can take several hours, days or even months. Scientific and in-

novative solutions are needed to face this problem. Since hardware is getting cheaper and cheaper and

processors exhibit more and more cores, execution time of tasks can be dramatically reduced.

Thus, LigandScout makes use of multiple cores to split up tasks into multiple small tasks that can be

executed in parallel. But there is more to it than that. LigandScout comes with a whole framework to

execute these small tasks not only on multiple cores on a single machine, but in a network on multiple

computers using all resources available to speed up execution.

2.5.1. iworker

To use computers connected through the network, the so called “iworker” has to run on each machine in

the network. The iworker is a stand-alone application that can be started either in the command-line or

as a graphical user interface application. Each iworker can execute multiple tasks in parallel to take full

advantage of multi-core and/or multi-processor systems. While the iworker is running, it listens through

a network port for incoming tasks. This port needs to be specified in the iworker Settings and Prefer-

ences/Distributed Calculation Settings. Make sure that the system administrator has opened that port!

To keep an overview about the iworker in the network, they are monitored by the Network Monitor. Once

the iworker receives a task it executes it and sends the result back to LigandScout. LigandScout collects

all the results of the small tasks and displays the progress and the overall result.

You can stop an iworker whenever you want. Results will never get lost, even if the machine running

the iworker has crashed unexpectedly. Tasks which were in execution, just when the iworker stopped

or crashed, will simply be restarted on another iworker. Furthermore, iworkers can be started on the fly.

LigandScout will make use of them as soon as they are started.

To use this opportunity of distributed calculations, you need to enable this mode in the Preferences/Dis-

tributed Calculation Settings. iworkers that are used by LigandScout can be added or removed in the

list of iworkers in the Preferences. If a listed iworker is not running or cannot be connected to, Ligand-

Scout will regularly retry to connect. In the meantime all available iworkers will be used. Optionally,

LigandScout can find iworkers automatically, if they run on a LAN (Local Area Network) by using UDP-

Multicast (This works only if broadcasting is enabled by the system adminisitrator!).
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To prevent idle time between finished tasks and new incoming tasks, which would cost performance,

the iworker takes more tasks than it can execute in parallel and puts them into a so called “Work Queue”

(queued tasks). Whenever a task execution has finished the iworker starts to execute the next task in the

queue with no idle time in between. Preventing idle time as much as possible increases the execution

performance.

How to start the iworker

The iworker can be started in two ways: The stand-alone GUI and through the command line.

The stand-alone GUI

Press on the iworker application icon to start the iworker GUI. It consists of an information overview

about the iworker, option settings to be adjusted to your needs and a button that starts/stops it.

Figure 2.6. iworker

iworker Information

This information gives an overview of the status of the iworker. The CPU Usage shows the overall

processor load of the machine running the iworker. The number of tasks that are currently processed

are displayed in the Tasks in Execution field. The next field called Connections represents the number

of nodes (LigandScout) that are connected to this particular iworker. The value of the Queued Tasks

informs you about the number of tasks in the Work Queue. The Total Executed Tasks implies the number

of tasks that are executed so far. Whereas, the Total Execution Time is the time that the iworker spends

for executing the tasks. The Overall Running Time field shows the sum of idle time and the execution

time (time between starting and stopping the iworker). Note that restarting the iworker does not reset

the number of tasks, total execution time, and overall running time, but continues the counting.

iworker Options

Pressing the Options button, a dialog appears for changing the iworker settings.
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Figure 2.7. iworker Options

If the Discoverable setting is enabled, the iworker can be detected in the network. If disabled, the only

way to find this iworker is to define it in the iworker list. This list consists of addresses of the iworkers

and are specified in the LigandScout  Preferences/Distributed Calculation Settings chapter. To set the

maximum number of tasks executed in parallel, just fill an appropriate value in the Parallel Tasks field.

This number is limited to the available number of cores (e.g. maximal 2 on a dual-core system, maximal

4 on a quad-core system). In the Network Interface field you can select the network device to use. The

Incoming Port represents the network port where the iworker listens for incoming tasks. This port has

to be opened from your system administrator (TCP port). Note that if the options settings of the iworker

are changed, during the iworker runs, the iworker has to be restarted to make these changes active.

The logging messages of the iworker can be shown in the console or redirected to a specified file. In

the drop down box you can select the logging level which defines how much information of the log will

be provided. Raising the level leads to a more detailed output. Choose between off, low, medium, high

and highest.

Log Level Description

off no network log messages

low network errors and warnings

medium connection info messages are shown

high high-level protocol messages

highest debug (very verbose)

2.5.2. Network Monitor

The Network Monitor can be used to observe the iworkers in the network. The iworkers can be detected

in two ways. You can specify the network addresses of the iworkers in the appropriate list of the Network

Monitor Preferences. Secondly, iworkers are automatically found in the LAN when the Auto-detectable

Option of the iworker is activated and provided that the broadcasting are enabled.

The Network Monitor consists of an  iworker Information Table, that provides a detailed overview about

the iworkers and a Log View for error handling.
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Figure 2.8. Network Monitor

iworker Information Table

The iworker Information Table shows information about the current state of all iworkers found in the

network. Each row represents an iworker and displays following information about that iworker: Network

Addresses of the iworkers (Addresses), number of nodes (LigandScout) that are connected to this par-

ticular iworker (Connections), number of CPU's (CPU), CPU usage of the machine running the iworker

(CPU Usage), number of tasks that are currently executed (Running Jobs), number of queued tasks

(Queued Jobs) and Enabling Log to view errors, warnings and other information about the iworker (Log).

Note: Disabling the Log decreases the network-traffic.

Log View

The Log View displays errors, warnings or other useful information about the iworker. The Log shows

only entries of iworkers selected in the iworker Information Table. If no iworker is selected, entries are

shown for all iworkers. Any selection in the iworker Information Table can be reseted by clicking on an

empty area in the iworker Information Table.

The detail level of the Log can be changed by the three Log Level buttons "Error", "Warning", and "Info".

The first level "Error" shows only the errors (bold and red). The second level "Warning" illustrates the

warnings (bold) and errors (bold and red). The last level "Info" shows all information of the iworker

including warnings and errors.

Furthermore, a text filter can be set to show only those entries that contain the specified text. To apply

such a filter, type the text into the filter area and press the Filter button. To disable the text filter press

the Cross button that is shown when a text filter is successfully applied to the Log. You can clear the

Log by pressing the Clear button. Note: Incoming Log entries are kept in temporary files. These files are

deleted when the Network Monitor is closed and whenever the Clear button is pressed. It is a good idea

to clear the Log if the temporary files require too much hard disc space. Never delete the temporary files

manually! If the space in the Log View is exceeded the Network Monitor automatically scrolls to the last

incoming entry. Automatic scrolling can be enabled or disabled by toggling the Lock button.
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Network Monitor Preferences

Figure 2.9. Network Monitor Preferences

In the Network Monitor Preferences dialog you can customize the logging settings and manage the list

of iworkers in the network.

You can choose if the logging of the message traffic will be shown in the console or redirected to a

specified file. In the drop down box you can select the logging level which defines how much information

of the log will be provided. Raising the level leads to a more detailed output. Choose between off (no

network log messages), low (network errors and warnings), medium (connection info messages are

shown), high (high-level protocol messages) and highest (very verbose for debug).

Add or remove iworkers by adding or removing their network addresses. A network address has the form

HOSTNAME:PORT or IP_ADDRESS:PORT (e.g.: localhost:4283, 135.27.1.119:1894). HOSTNAME or

IP_ADDRESS is the host name or ip-address of the iworker, and PORT is the TCP-port the iworker is

listening to. (Remember that the system administrator has to open that port on the machine the iworker

is running on!).
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Chapter 3. LigandScout Perspectives
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LigandScout offers several solutions to handle complex problems in drug design using pharmacophore

models. These approaches are divided into four perspectives:

1. Structure-Based Modeling Perspective

2. Ligand-Based Modeling Perspective

3. Alignment Perspective

4. Screening Perspective

The Structure-Based Modeling Perspective is divided into two views: PDB View and Bookmark View.

The PDB View allows for analyzing the binding site of ligand-receptor complexes. Active sites including a

part of the macromolecule, the ligand(s) and the pharmacophore can be stored in the Bookmark View for

later investigation. If no 3D data of proteins are available the Ligand-Based Modeling Perspective offers

possibilities to generate pharmacophores from a set of active compounds. In the Alignment Perspective,

insight on the structural relationship of ligands as well as the fit of compounds to pharmacophores can be

gained by aligning pharmacophores and/or molecules (single conformation). The Screening Perspective

allows for pharmacophore-based virtual screening of large molecule databases.

The advantage of the perspective concepts is that you can simply switch between the four perspectives

and exchange data from one to another. This makes LigandScout flexible in its application while the

graphical user interface remains structured clearly. All perspectives include dedicated elements that are

backed by several “Basic User Interface Modules”, such as a Hierarchy View, a 2D View, and a 3D View

which provide basic information about your data.
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3.1. Basic User Interface Modules
LigandScout is composed of Basic User Interface Modules and widgets which helps you to display and

navigate through your data. Some of them appear in all five perspectives, such as 2D View, 3D View,

Hierarchy View and Copyboard Widget. Each perspective has individual control panels - for example:

the PDB Panel in the Structure-Based Modeling Perspective. Special modules like the Library View are

only available in the Structure-Based Modeling Perspective and Screening Perspective.

Figure 3.1. Basic User Interface Modules: Hierarchy View (1), 3D View (2), 2D View (3),

Copyboard Widget (4) and control panel (5)

3.1.1. 3D View

The 3D View represents the most important interaction of LigandScout. It is a powerful tool to verify

and revise structural data, which is crucial for the automated generation of restrictive pharmacophore

models.

Working with the 3D View

Since PDB data does not provide information on atom hybridization states and bond types, LigandScout

uses a sophisticated ligand interpretation algorithm for the assignment of bond types via molecular ge-

ometry analysis. Data quality of PDB ligands is known to be an issue in molecular modeling. Therefore,

manual verification of the automatically deduced ligand structure is highly recommended. Moreover, it

represents a vital verification step for the subsequent pharmacophore generation process.
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Navigation Basics in 3D View

Position the mouse pointer in the 3D View and press the LEFT mouse button to rotate the items shown

in the 3D View. Depending on your hardware setup, scrolling your mouse wheel or pressing the MID-

DLE/WHEEL mouse button and moving your mouse up/down allows you to zoom. The structure can be

translated by pressing the RIGHT mouse button while moving. A comprehensive list of mouse controls

is provided in the Section A.4, “LigandScout Mouse Bindings”.

Selecting Elements of the 3D Viewer

Select a single element by a single LEFT mouse click on it. Keeping SHIFT pressed allows you to select

consecutive elements, CTRL (Command on MAC) pressed lets you select individual items. The Select

command in the Edit menu picks all elements of ligand, environment or pharmacophore. Select All is

identical to hotkey CTRL+A (Command+A on MAC) and picks all items at once. Please refer to Mouse

Bindings for more details on mouse interactions.

Displaying Essential Information on Selected Items

The Toggle Tooltips feature in the toolbar provides relevant characteristics of the currently selected item

in a transparent frame adjacent to the selection:

Item Characteristics

Atom Geometry, position, compound
name

Bond Bond type, length, ring +/-

Pharmacophore Sphere Type, position, tolerance

Pharmacophore Vector Type, orig. position, targ. position

Changing Atom Types

Atom types are changed quickly by selecting an atom and pressing the character of the respective

element in your keyboard (this works for C, N, O, S, P). Apart from using these hotkeys, the Change

Atom Type button in the toolbar gives you full access to the periodic system, where you can pick the

desired element.

Creating (New) Atom Bonds

To create a new bond between two atoms, keep SHIFT pressed and select two atoms. Then select

the Create New Bond icon. If you want to change a bond type, select the bond and press 1 (SINGLE),

2 (DOUBLE) or 3 (TRIPLE) on your keyboard to change the current bond into the respective bond

type. Additionally to these shortcuts, the Change Bond Type button in the tool bar provides this editing

function.
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Creating New Atoms

Create a new atom by selecting a free hydrogen atom of a ligand. Change the selected hydrogen atom

to the atom of your choice. This procedure automatically adds the new atom to the ligand and roughly

optimizes the structure in the neighborhood of the added atom to avoid sterical clashes. You can use

the hotkeys CTRL+ALT+O (Command +ALT+O on MAC) to minimize the ligand until a local minimum

is reached. For more information on this please see Section 9.3.4, “Force Field: Minimization”.

Deleting Atoms, Bonds, and Pharmacophore Features

Select an atom, bond, or pharmacophore feature you want to delete and press the DEL button on

your keyboard. The Delete button in the tool bar also provides this functionality. Multiple selection is

enabled for all elements; e.g. you can select various atoms, bonds, and pharmacophore features for

simultanous deletion. See Section A.4, “LigandScout Mouse Bindings” for additional information on

multiple selection.

Adding Distance/Angle Monitor

To measure the distance between two atoms, just keep SHIFT pressed and select two atoms. Select

the Add Distance Monitor in the Render Control menu or the Add Distance Monitor icon in the tool bar.

To measure the angle between three atoms, keep SHIFT pressed and select three atoms. Select the

Add Angle Monitor in the same menu as above or the Add Angle Monitor icon. To delete the distance

or angle measurement, click on the shown value and press the Delete icon.

Rotate around a Bond

To rotate a part of a molecule around a specific bond, select its two neighbored bonds on either sides

and press on the Angle Monitor Add Angle Monitor icon. Select the angle value and keep the LEFT

mouse pressed to rotate the bond. To rotate a bond on the distant side of the molecule, simply rotate

the camera to bring the bond to the front.

Editing Charges

Correct charges are crucial for the generation of valid pharmacophore models. To adjust the charge of

atoms, make a selection and use the Increase Charge / Decrease Charge buttons or in the menu bar

Molecule > Increase/Decrease Charge of Selected Elements command. Please note, that Increase/De-

crease Charge functionality is only available on high-resolution displays.

Defining Elements as Core or Environment

In special cases you may want to shift elements from core to environment and vice versa. Just select

the atoms and/or bonds you want to move and use the Move Selection to Macromolecule/Ligand Side
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command located in the Molecule menu. The respective buttons Move to Environment and Move to

Core provide instant access to this LigandScout feature.

Returning to the Basic Structural Data

The Re-Interpret Core Molecule button lets you recalculate bond valences, aromaticity, hydrogen posi-

tions, and stereo chemistry from scratch. This feature is useful if you lose track of your modifications.

However, if you only want to undo your last modification(s) you can use the Undo feature via the Undo

button or in the menu Edit > Undo.

Advanced Render Control Settings

LigandScout provides useful render control options such as e.g. Wide Angle View and Show Tool Tips.

Please refer to the section called “Projection” and the section called “Behavior” for more information.

3.1.2. 2D View
The 2D View displays the structural formula of ligands and its generated pharmacophore.

Figure 3.2. 2D View

Like its 3D counterpart, the 2D View is used for fast atom and bond type corrections. Furthermore,

LigandScout now allows you also to edit the pharmacophore features directly in the 2D View in the same

way as described for the 3D View. Select one or several pharmacophoric constraints by single click

on the respective residue identifier(s) located nearby the pharmacophore feature. There are no major

differences in handling between both tools. Selections and manipulations are identical to that described

for the 3D View. Both the 2D depiction of the ligand and pharmacophore can be exported in several

file and graphics formats.
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3.1.3. 3D Widgets

Copyboard Widget

The Copyboard Widget gives the opportunity to transfer your chemical data between different perspec-

tives of LigandScout (Structure-Based Modeling, Ligand-Based Modeling, Alignment and Screening).

Figure 3.3. Copyboard Widget

You can toggle this widget on/off in the menu Window > 3D Widgets > Copyboard Widget. Molecules

are added from one perspective to another using the Copy current Ligand(s) to icon. Pharmacophores

are added with the Copy current Pharmacophore to icon, respectively. Exclusively active sites (binding

pockets) can be transfered only from the Structure-Based Modeling Perspective to the Bookmark View

by clicking on the Copy current binding site to icon.

Please be reminded that you can add items to the Bookmarks Panel only from the PDB View. In other

words, you have to switch to PDB View of the Structure-Based Modeling Perspective to add the current

molecule or pharmacophore to the Bookmarks Panel. The items can be placed individually within the

3D View.

Some examples: If an active site is currently shown, this allows you to add the ligand molecule to

the Alignment Panel by clicking on the icon Copy current Ligand(s) to Alignment Perspective. If the

pharmacophore was calculated you can add it to the Screening Perspective by clicking on the icon

Copy current Pharmacophore to Screening Perspective. The transfered items can be placed individually

within the 3D View.

The following table gives an overview of the items that can be exchanged between the perspectives.

From\To PV LBP AP SP BV

PV - L, P L, P P A

LBP L, P - L, P P -

AP L, P L, P - P -

SP L, P L, P L, P - -

BV L, P L, P L, P P -

Table 3.1. Exchanging data between perspectives: ligand/s (L), pharmacophore/s (P), active site

(A), Structure-Based Modeling Perspective: PDB View (PV) and Bookmark View (BV); Ligand-

Based Modeling Perspective (LBP), Alignment Perspective (AP) and Screening Perspective (SP)
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Alternatives Switcher

Figure 3.4. Alternatives Switcher

In case of navigating within your molecule library, select more than one compound in the Library View

and the Alternatives Switcher automatically appears. The widget allows you to visualize the previ-

ous (Show Previous Compound), next (Show Next Compound) and all (Show All Compounds) visible

compound(s). The Alternatives Switcher can be de/activated in the menu Window > 3D Widget.

Conformation Switcher

Figure 3.5. Conformation Switcher

The Conformation Switcher navigates you through the conformations of your selected compound. The

widget automatically appears if conformations are available and can be toggled in the menu Window

> 3D Widgets.

Tautomer Switcher

Figure 3.6. Tautomer Switcher

You can switch through available tautomers of a compound by using the Tautomer Switcher. The widget

can be toggled in the menu Window > 3D Widgets.

3.1.4. Hierarchy View
The Hierarchy View shows a tree diagramm of the current macromolecule-ligand complex as you are

used from various file commanders. A click on the '+' box on the left of the branch title opens a sublevel.
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The Collapse All button lets you return to the starting view of this display. To toggle the visibility of an

element click on the Toggle Visibility icon. The Change Color icon allows you to change the element

color.

Figure 3.7. Hierarchy View

Selecting Items with the Hierarchy View

A single LEFT mouse click on a branch title selects all elements of all subordinate levels. Keeping

SHIFT pressed allows you to select consecutive elements, CTRL pressed lets you select and deselect

individual items.

The Link with Selection icon connects the selection in the 3D View to the Hierarchy View. As you select

items in the 3D View with this option enabled, Hierarchy View opens all necessary sublevels to focus

and highlight the currently selected items.

3.1.5. Library View

The Library View allows you to efficiently investigate collections of small organic molecules. It is espe-

cially useful for the analysis of pharmacophore screening and docking results.
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Figure 3.8. Library View

Importing Libraries

Compound collections can be imported to the Library View using the Open or Insert command in the File

menu. The LigandScout I/O framework currently supports MDL SD, SMI, MOL2 and LDB file formats

for loading molecule libraries.

The Open command is used to display the molecule exclusively in the Library View. Select a file con-

taining the molecules you want to analyze with LigandScout and click Open File. LigandScout now im-

ports all ligands, activates the Library View and shows all properties contained in the loaded library.

Opening libraries with no 3D coordinates such as SMI files (or also SD(F) possible) displays the com-

pounds only in 2D.

The Insert command (CTRL+I) can be used in two ways: You can open a file containing an particular

ligand and/or a pharmacophore and then insert a library. The second possibility is to load a PDB code

and zoom into the binding site to insert the library. The loaded data have to be in the correct coordinate

frame to yield a meaningful result. For instance, if the molecule to be injected was docked into the active

site before, this restriction will be fulfilled. If the coordinate frame is not correct, the inserted ligand will

be placed into the coordinate frame of the active site whether it makes sense or not.

Navigate in the Library View

In order to view compounds of your collection, make a single click on a compound row of the library to

visualize it. To extend your selection, press CTRL and choose additional compounds. The scroll bar on

the right side lets you navigate through your compound collection.

If you select more than one molecule in your library, you can navigate within your selection and show

the molecules one by one. Thus, the Alternatives Switcher is automatically activated and you can switch

to your previous, next or all molecule(s). The widget can be toggled in the menu Window > 3D Widgets.

In concordance to the handling within the Hierarchy View you can also select several ligands for visu-

alization. The visibility of the library compounds can be toggled with the Toggle Visibility icon in the
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Hierarchy View. According to a library insertion into a binding pocket, the original ligand (core molecule)

remains visible (if existing) in the binding site unless it is erased or defined hidden in the Hierarchy View.

This is especially useful if you e.g. want to compare your docking results to a binding pose of a known

active compound.

If you add a molecule from another view to the PDB View, a pop up dialog asks if you want to Append to

Library, Replace Core Molecule or Inject Only. The latter one adds the molecule only to the Hierarchy

View.

You can arrange the property columns of the Library View individually by moving the column identifiers.

Click on a column identifier (e.g. Name) to sort the table by this property. Another click on the same

column identifier flips the sort order. For instance you could sort your docking/pharmacophore screening

results by decreasing score. In this way you can use LigandScout to investigate your virtual screening

results ranked by relevance.

To toggle on/off specific column identifier, click on a column identifier using the RIGHT mouse button.

A list of available identifiers appears where you can enable or disable columns by de/selecting their

appropriate check box.

On the upper left corner of the Library View LigandScout allows to apply filter criteria to the compound

table: Press CTRL and click on a column identifier to select the parameter you want to use for filtering

(default: Name). Subsequently, click on the Add Filter label and a text box appears. When you enter

a filter criterion, the table will be updated instantly, considering the currently applied criterion. To undo

the filtering erase the filter criterion in the text box.

Hide all compounds of the Library View with the Hide All Compounds icon located on the upper right

corner of the Library View. Next to this icon you find the Align Molecules on Injection into the Binding

Site icon, which allows you to directly align the selected molecule(s) to the active site by overlapping

the feature tolerances. Enabling Align selection to Pharmacophore/Core Molecule aligns and scores

the selection to the context.

3.2. Structure-Based Modeling Perspective
The Structure-Based Modeling Perspective offers a user interface ready to explore PDB complexes and

to derive pharmacophores from the binding sites. This perspective is divided into two views: the PDB

View and the Bookmark View.
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3.2.1. PDB View

Besides loading data from file, a very convenient way to obtain ligand-macromolecule complexes is to

directly retrieving PDB complexes online. This task can be performed by using the dedicated control

panel, the PDB Panel.

Another important use covered by the Structure-Based Modeling Perspective is investigating small-

molecule libraries. This can be done either with or without a particular binding site as context by using

the Library View.

Figure 3.9. The PDB View of the Structure-Based Modeling Perspective (1): PDB Panel (2), Zoom

Out Widget (3) and Bookmark View button (4)

PDB Panel

The PDB Panel displays important information on the current macromolecule-ligand complex, provides

instant PDB access and is composed of three components:

• PDB 4-letter Code Instant Access Box

• Essential characteristics of the PDB file

• Ligand Selector
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Figure 3.10. PDB panel

LigandScout uses a "two-level" file storing strategy, the Local and Shared Repository. If a PDB code is

entered in the PDB 4-letter code field of the PDB Panel, LigandScout tries to find the associated files

in the Local Repository, the first stage. If unsuccessful, LigandScout will check the Shared Repository

which represents the second level.

Title, class, source, resolution, deposition date, and the experimental type of the current PDB complex

are provided in a separate text box.

The Ligand Active Site Selector allows instant access to the active sites of the current complex. Simply

click the drop-down menu and select a ligand to zoom into the respective active site. If you are already

in an Active Site View the view will be switched without an animation.

3D View Depiction Modes and the Zoom Out Widget

LigandScout's 3D View provides two distinctive macromolecule-ligand complex depiction modes in the

Structure-Based Modeling Perspective. Startup sets the display to Macromolecule View. LigandScout

memorizes views and positions. Thus, if you change from Active Site View to Macromolecule View using

the Zoom Out Widget you will get your previous view setup of the current display. The visibility of the

Zoom Out Widget can be toggled in the menu Window > 3D Widgets.

Figure 3.11. Zoom Out Widget

The Macromolecule View illustrates the global structure and current orientation of the macromolecule.

You can switch to the active site by a LEFT mouse click on the active site (blue box). To change back
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to the Macromolecule View just click on Zoom out button of the Zoom Widget. The Zoom Widget can

be placed individually within the 3D View.

Macromolecule View

The Macromolecule View provides structural information on the macromolecule and the ligand's position

within it. This view gives you a clearly arranged overview on the current PDB complex. Alpha-helices

are shown in dark blue, beta-sheets in light blue, and double helices in brownish-orange. Consecutive

amino acids which could not be categorized are shown in gray. If some amino acids or nucleic acids

are missing, a gray dashed line will be shown.

Figure 3.12. Macromolecule View

Use your mouse to navigate within the 3D View. A single click on Center Ligand and Environment in the

toolbar lets you return instantly to the Macromolecule View starting position.

In Macromolecule View, four different rendering modes of both macromolecule and ligand are available.

Use the Ligand Default Style submenu of the Render Control menu or the Change Render Style of Se-

lected Atoms icon to change between Line, Ball and Stick, Stick and Spacefilling/CPK ligand rendering

mode. Similarly the rendering mode of the macromolecule is changed with the Protein Backbone De-

fault Style submenu of the Render Control menu or the Toggle Hydrogen button. LigandScout supports

Lines, Splines, Snake and Ribbon styles.

Active Site View

The Active Site View displays structural information of the ligand and its essential surrounding macro-

molecular environment in detail. LigandScout displays only amino acids or nucleic acids surrounding the
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ligand while suppressing moieties irrelevant for macromolecule-ligand interaction. The respective cutoff

value is defined in the Preferences/Structure-Based Modeling Settings as  Interaction Cutoff Threshold.

Figure 3.13. Active Site View

You can easily switch from Macromolecule View to Active Site View by selecting a ligand in the Ligand

Active Site Selector  (PDB Panel) or by selecting a yellow cube surrounding the ligand in the 3D View.

Use the Center Ligand Molecule icon in the toolbar to recenter the ligand. Center Ligand and Environ-

ment button lets you recenter the current active site. A click on the Zoom out button of the Zoom Out

Widget in the 3D View lets you return to the starting position in the Macromolecule View.

Rendering Options of the Active Site View

The Active Site View provides additional rendering options as available in Macromolecule View. The

additional render options are found in the Render Control menu.

Ligand Rendering Settings: Ligand Default Style Submenu

Toggle on/off hydrogen depiction with the Show/Don't Show Hydrogens radio buttons or the Toggle

Hydrogen icon. Show Hydrogens Stubs reduces the size of hydrogens to stubs. Show Templates acti-

vates the depiction of default geometric templates depending on the hybdridization-state of the currently

selected atom. Show Interactions displays all possible interactions of the currently selected atom. Show

Ionic Interactions displays ionic interactions between metals and non-metals. The Pickable check box

sets the ligand selectable/unselectable.

Environment Rendering Settings: Environment Default Style Submenu

The Environment rendering submenu corresponds in large part to the respective ligand menu and lets

you select different rendering modes and define hydrogen handling. The Show Templates option acti-

vates the depiction of default geometric templates depending on the hybdridization-state of the current-
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ly selected atom. The Pickable check box sets all of the atoms in the environment as selectable/uns-

electable.

Selection Rendering Settings: Selection Submenu

The Selection submenu lets you customize the rendering of the current selection. LigandScout provides

four different modes: Line, Ball and Stick, Stick and Spacefilling/CPK.

Pharmacophore Rendering Settings: Pharmacophore Submenu

The Pharmacophore submenu enables you to switch on/off pharmacophore and excluded volume de-

piction or use the Toggle Exclusion Volume Spheres Visibility icon. The Pickable check box sets the

pharmacophore selectable/unselectable.

GRID Maps Visualization

The Structure-Based Modeling Perspective of LigandScout allows you to visualize GRID maps directly

in the protein binding site. To import GRID maps into the binding site, select in the menu File > Open.

LigandScout will ask you for the kind of GRID probe to be visualized.

The GRID maps are especially useful for the investigation of LigandScout pharmacophores. These maps

provide information on the importance and intensity of certain protein-ligand interactions and may help

you to discriminate between crucial pharmacophore features and constraints that are less important.

Pharmacophoric features located in areas that indicate strong molecular interactions by GRID analysis

(using compatible probes of course) are likely to be highly relevant for the binding of the ligand to the

protein.

Since GRID maps do contain absolute coordinates, you need to load the appropriate binding site in

order to have the GRID map correctly aligned with the pocket. At best, load the particular binding the

GRID map has been calculated for.

3.2.2. Bookmark View

The Bookmark View stores active sites of macromolecules. This has the advantage that you can analyze

the binding sites of interest one after the other without the need of loading them through the PDB Panel.

The active sites are managed in the Bookmarks Panel.
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Figure 3.14. The Bookmark View of the Structure-Based Modeling Perspective: Bookmarks Panel

(1) and PDB View button (2)

Bookmarks Panel

Figure 3.15. Bookmarks

The Bookmarks Panel allows you to access your bookmarked active sites which are represented by

the Bookmark icon. Bookmarks of the current Active Site View are stored using the Copy current bind-

ing site to icon located on Copyboard Widget of the the Structure-Based Modeling Perspective. For

instance, load 1ke6 into the Structure-Based Modeling Perspective and zoom in. Add the active site

to the Bookmark View by the Copy current binding site to. Repeat this procedure for 1ke7 and 1ke8.

To access a bookmarked active site simply click on its name in the Bookmark List and the appropriate

active site is shown in 3D View. You can erase a certain bookmark entry by selecting it and press the

Delete Bookmark button.
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3.3. Ligand-Based Modeling Perspective
Pharmacophore model creation strongly depends on the PDB complex when you choose the Struc-

ture-Based Modeling method. If no structural data of the protein-ligand complex is available or the com-

plex lacks quality, then the Ligand-Based Modeling method is used. LigandScout's Ligand-Based Mod-

eling Perspective allows you to generate pharmacophores from a set of ligands that bind to one target

protein and provide similar biological activity (so called active ligands). LigandScout provides techniques

which help to prepare an active set by clustering, include molecule flexibility by conformational analysis

and an efficient alignment algorithm to derive pharmacophore models from a ligand-set.

The Ligand-Based Modeling Perspective includes Basic User Interface Modules, a Ligand-Set Table

and Results Table.

Figure 3.16. Ligand-Based Modeling Perspective (1), Tool bar (2), Ligand-Set Table (3), Results

Table (4) and Ligand-Set menu (5)

3.3.1. Importing Ligands

Ligand-based pharmacophore modeling requires a set of two or more input ligands to generate char-

acteristic pharmacophores. There are three different types of input ligands: Training-Set, Test-Set and

Ignored Ligands. The Training-Set molecules are used for the actual pharmacophore creation and the

Test-Set ligands are used to verify the resulting pharmacophores. Ligands that should not be included

in pharmacophore generation and testing can be marked as Ignored Ligands.

The input ligands may be provided in three different ways: You can import e.g. a ligand set file (*.lsd)

or add molecules to the existing Ligand-Set by selecting the Add Molecules submenu in the Ligand-Set

menu and choose the type of set to be added. Another alternative is to add your molecules by means

of the Copyboard Widget to the Ligand-Based Modeling Perspective.
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3.3.2. Navigation and Working with the Tool Bar

Ligand-Set Table

The navigation in the Ligand-Based Modeling Perspective is quite similar to the Library View, but with

a different focus. The Ligand-Set Table (after importing the ligands) shows the list of molecules which

serve as input for the pharmacophore generation process. The user can change ligand properties (e.g.

type, activity, etc.), filter [33] the table content, and select ligands to make them visible in the 3D (only

if 3D coordinates are present), 2D, and Hierarchy View. Like in the Library View, navigating through

available conformations is possible by using the Alternatives Switcher.

The ligands are colored differently to keep the overview. The Training-Set ligands are colored randomly

and ligands from the Test-Set and Ignored Ligands are marked gray. The color of the ligands can

be changed in the Hierarchy View. You can customize the type of a selected ligand by choosing the

appropriate type in the Ligand-Set Table or flag the ligand in the Ligand-Set menu. It is also possible

to change the activity of a ligand in this way.

In the Ligand-Set Table toolbar, buttons are provided for the main tasks in ligand-based pharmacophore

modeling. From left to right: ligand conformations can be created by OMEGA (Generate Conforma-

tions for Ligand-Set icon), the available ligands can be clustered according to a multi-conformational

alignment score (Clustering icon), and the automatic ligand-based pharmacophore creation (Run Lig-

and-Based Pharmacophore Creation icon) can be started. If conformations are already available, the

pharmacophore generator uses them directly for the pharmacophore creation, otherwise they are gen-

erated on the fly. Conformer generation, clustering and pharmacophore creation can be customized as

described in Section 9.2, “Ligand-Based Modeling Settings” and Section 9.5, “Alignment Settings”.

When a ligand-based pharmacohore creation run is successful, the Ligand-Set Table is automatically

updated and provides additional information such as feature patterns, number of conformations, and

the Pharmacophore Fit of the ligands matched with the selected result pharmacophore. The first digit

of the Pharmacohphore Fit score represents the number of matched features and the second one, the

RMSD value. The Feature Pattern of a ligand illustrates the color-encoded features that were matched

by the ligand. Thus you can see at first glance the distribution of the features and which of the resulting

pharmacohores are matched best by the Ligand-Set (frequency of matched features).

Results Table

The Results Table is positioned at the right-bottom corner of the Ligand-Based Modeling Perspective.

After the ligand-based pharmacophore generation process has finished the results are listed in this table

including the name and score. By default, the entries are sorted by score value in descending order,

but the user can change both the sorting order and sorting criteria by clicking the appropriate column

identifier.

Each entry of the Results Table represents a valid pharmacophore model (i.e. it consists of at least three

features) and stores the state of all Training-Set molecules (i.e. alignment pose and active conformation).

Selecting a resulting pharmacophore model updates the 3D View and 2D View to show the particular
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pharmacophore and aligned Training-Set molecules. Furthermore, score values and feature patterns in

the Ligand-Set Table are updated for the currently selected pharmacophore.

The range of the score values shown in the Results Table depends on the scoring function used (see

Ligand-Based Modeling Settings). If you select the Pharmacophore Fit scoring function then the score

value describes the number of matched features and RMSD. All other scoring functions produce nor-

malized values that range from zero to one, where one is the optimum.

The generated ligand-based pharmacophores may be transfered into other perspectives, where you

can export them in different file formats. Optionally, you can generate ligand-based pharmacophores

by using the command line as well. For further information, please see Chapter 7, Ligand-Based Phar-

macophore Design.

3.3.3. Biasing Pharmacophore Generation

Ligand-based pharmacophore creation can be influenced in two ways. The first one sets a user-defined

pharmacophore model to the starting point of the alignment procedure. The second directs the gener-

ation procedure by customized feature definitions.

User Defined Pharmacophore

During the ligand-based pharmacophore modeling process, ligands are ranked by their number of con-

formations. Then, starting from the ligand with the lowest number of conformations, their pharmacophore

models are aligned with the ones of the second ranked ligand. Ligand-based pharmacophores will be

composed from these alignments and aligned with the pharmacophores of the next ranked ligand and so

on. If you set a user-defined pharmacophore in advance, this pharmacophore is kept as the first phar-

macophore to be aligned to the pharmacophores of the following ligand. The advantage of this function-

ality is that the features of the user-defined pharmacophore are more likely to survive this procedure.

You can use this functionality by selecting in the menu Ligand-Set > Set Pharmacophore Bias and load

a pharmacophore of your choice. Alternatively, you can add a pharmacophore from another perspective

to the Ligand-Based Modeling Perspective using the Copyboard Widget.

User Defined Feature Definitions

Although, the first functionality stamps the ligand-based pharmacophore modeling by a user-defined

pharmacophore model, LigandScout allows you to provide additional customized feature definitions in

addition to LigandScout's standard feature definitions (built-in types). These chemical features will be

used temporarily for aligning the molecule, but will not be included in the resulting 3D pharmacophore.

You can access the custom feature functionality directly in the Ligand-Set menu or via the settings dialog

after clicking the Run Ligand-Based Pharmacophore Creation button in the Ligand-Based Modeling

Perspective.
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Figure 3.17. Customize feature definition

A custom feature is defined by several SMARTS patterns that specify the substructures where the fea-

ture shall (or shall not) be placed. For the definition of a new custom feature click on the New button

under the available Features panel and specify an ID (abbreviation) and name for the feature. To en-

able/disable the feature in the pharmacophore generation process click the Active check box in the

feature table.

To define or include SMARTS patterns for a feature click on the New button under the Include Patterns

List. Declare valid SMARTS patterns and specify tolerance spheres for the feature. Smarts patterns that

specify substructures where the particular feature shall not be placed (exclude patterns) are defined in

the same way except that you do not need to specify a tolerance.

If you want to make changes to your custom feature definitions, you can edit them by clicking on the

Edit button. To delete custom features as a whole or to delete only some include/exclude patterns of a

feature, select the desired features or patterns and click on the appropriate Delete button. To apply your

changes click the OK button on the bottom-right corner of the Edit Custom Features dialog. To reset

any of your changes click on the Reset Changes button.

Use the custom feature functionality when you want to put emphasis on certain common substructures

of the ligands in the alignment steps performed during the pharmacophore generation process. Note

that although the custom features will be considered in the pharmacophore creation process (if enabled)

they are not visible in the resulting 3D pharmacophores.
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3.4. Alignment Perspective
The purpose of the Alignment Perspective is to analyze common properties (features or reference

points) of pharmacophore models and/or small molecules by aligning them and generating shared or

merged feature pharmaocphores. Thus, the Alignment Panel and Alignment List help to manage your

elements in the Alignment Perspective.

Figure 3.18. Alignment Perspective (1), Alignment List (2) and Align & Merge menu (3)

3.4.1. Alignment Panel

The Alignment Panel allows you to align pharmacophores and/or molecules as well as generate shared/

merged feature pharmacophores.

Molecules and pharmacophores from other perspectives are added to the Alignment Panel using the

Copyboard Widget or through the menu File > Alignment > Import.



LigandScout Perspectives

45

Figure 3.19. Alignment Panel

The Alignment Panel consists of an icon toolbar, the Show Advanced Options Check Box, the Alignment

List containing molecules and pharmacophores, a slider, and an RMS label.

Icon Toolbar

Use Center All Visible Structures to move the center of all currently visible structures to one point in 3D

space. To set a reference element, perform a list selection on a single element in the Alignment List and

click Set Reference. Clicking this icon again will reset a previously set reference element. To perform

an alignment, select two or more elements from the Alignment List (list selection) and click the Align

Selected Elements. Similarly, to generate a shared feature pharmacophore select two or more elements

from the Alignment List and click Merge Pharmacophores and Interpolate Overlapping Features. To

remove elements from the Alignment List, perform a list selection on the desired elements and click

Delete icon.

Show Advanced Options Check Box

Figure 3.20. Advanced Options

If this check box is activated, LigandScout offers two pharmacophore and/or molecule alignment modes:

The alignment based on pharmacophore features, or on the position of the respective protein residues

(reference points).
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Align by features allows to align both ligands and pharmacophore models by an algorithm examining

the best possible pharmacophoric feature overlay. If no reference element was specified one of the

selected elements will be chosen randomly.

Align by reference points is a useful tool to investigate protein-ligand complexes of structurally related

targets. It allows for aligning ligands with respect to the surrounding protein residues. In this way the user

is able to directly compare the absolute position of one or several ligands within the aligned binding site.

If you want to include available conformations in the alignment process, enable the Align flexibly check

box.

Alignment List

Molecules are represented by the Molecule icon and pharmacophores are represented by the Pharma-

cophore icon. Molecules and pharmacophores can be accessed (and selected for alignment) by clicking

on their names in the Alignment List.

You can also select several elements next to each other by locating the mouse pointer on a single

element, pressing the LEFT mouse button and dragging over the areas you wish to select. This list

selection will be highlighted in the associated lines. To select an element click on the Unselected icon

and to deselect this element again click on the Selected icon in the appropriate line. This special selection

allows for a coordinate-transforming rotation and translation in the 3D Viewer: Select a ligand in the 3D

View and press ALT+SHIFT+LEFT mouse button for rotating and ALT+SHIFT+RIGHT mouse button for

translating (Command+Option on MAC). These special transformations can be used to manually align

a structure to another one or to separate two aligned ligands for instance.

To toggle the visibility of an element click on the Toggle Visibility icon or to switch from blurred or de-

saturated color representations to normal representations click on the Context Representation icon and

to switch back click on the Focused Representation icon. The blurring feature is activated/deactivated

with the Alignment Perspective/Use Blur (SDOF) command in the Render Control menu.

Context Menu

The Context menu extends the set of available user interactions by providing additional features for

handling elements in the Alignment List. Select an element in the Alignment List and press the RIGHT

mouse button to open the Context menu.

Figure 3.21. Context menu for alignment
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Set “Element Name”
As New Reference

This option will set the currently selected element as new reference
element.

Hide/Show Toggles visibility of the currently selected element.

Move to Context Toggle the context state of the currently selected object.

Save as... Save the currently selected object.

Rename Rename the currently selected object.

Duplicate “Element
Name”

Duplicate the currently selected element and add the duplicated el-
ement to the list.

Delete Delete the currently selected element.

Create Pharma-
cophore

Creates a pharmacophore of the currently selected ligand(s). Lig-
andScout thereby places all common pharmacophoric features on
the molecule(s).

Create new confor-
mational model

Creates conformations to the selected molecule.

Slider and RMS Label

The slider and the RMS label will stay inactive if an alignment was performed for three or more elements

or if there was a perfect alignment (which is the case for a molecule aligned to its pharmacophore or for

two instances of the same structure). If there were exactly two elements to be aligned which did not show

a perfect alignment, the slider as well as the RMS label will become active and will give more information

of the currently shown alignment. Use the slider to iterate over the alignments. The alignments are sorted

according to a score, the best ones will be at the beginning, whereas values reflecting poor alignments

will be at the end of the slider range. The RMS label gives the RMS (root mean squared) of the position

deviances of all valid feature matchings. The number in brackets represents the number of valid feature

matchings.

Render Options

To use the render options, select in the menu bar Render Control > Alignment Perspective Defaults. Use

Blur (SDOF: Semantic Depth of Field) allows advanced blurring of objects. The effect is only visible if the

corresponding check box of ligands/pharmacophores in the Alignment Panel is activated. Blurring may

cause graphical issues or slow down the performance on low end computer systems and is therefore

recommended only with suitable hardware equipment. Show Reference Points allows to visualize the

position of the protein residues when using alignments based on reference points. Show Reference Point

Names places residue identifiers to this reference points. Show Feature Tethers visualizes the affiliation

of corresponding pharmacophoric features with tethers. Show Reference Point Tethers visualizes the

affiliation of corresponding protein reference points with tethers.



LigandScout Perspectives

48

3.5. Screening Perspective
Searching in a large molecule collection for molecules possessing a specific pharmacophoric pattern

is the next step in drug design. LigandScout's Screening Perspective provides the possibility to screen

large molecule databases against 3D pharmacophore models.

The Screening Perspective consists of a special control panel, the Screening Panel and the Library View.

Figure 3.22. Screening Perspective (1), Screening Panel (2) and Library View (3)

3.5.1. Screening Panel

The Screening Panel allows you to manage your molecule databases and pharmacophores. It contains

an icon toolbar, the Show Advanced Options Check Box, the Molecule Database List and a Pharma-

cophore List.
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Figure 3.23. Screening Panel

Icon Toolbar

Use the Load Database icon to import a database (*.ldb) into the Molecule Database List or use the

menu File > Open. A click on the Perform Screening icon starts the screening process. To show the ROC

curve (receiver operating characteristic) press the Plot ROC Curve icon. If the screening process has not

started yet, the screening starts automatically and after that the ROC curve is shown. Pharmacophores

can be removed from the Pharmacophore List by selecting them in the Pharmacophore List and then

pressing the Delete Pharmacophore icon.

Show Advanced Options Check Box

Figure 3.24. Show advanced options settings

To activate Show Advanced Options, click on the check box. You can choose the scoring function

(default: Pharmacophore Fit), how many features of the pharmacophore should be omitted, stopping
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after first matching conformation and if excluded volume clashes should be checked during the screening

process. Another precondition for a hit is that the molecule has to match a minimum of three features

found in the pharmacophore model! You can change these settings in the Library Screening Settings

in the Preferences.

Molecule Database List

After importing a database through the Load Database icon or the File > Open, the database is added to

the Molecule Database List. For loading time reasons, the molecules in the databases are not shown in

the 3D View. To include a database, select the check box to the left of the appropriate database name.

The check box will be marked green which assigns the database as active. Clicking again on this check

box will mark this check box red, which symbolizes that the database includes inactive compounds.

You can select more than one database but at least one needs to be marked as active. To remove a

database select the cross button to the right of your database in the list. If you want to see the molecules

in a database, simply switch to the Structure-Based Modeling Perspective and open the database.

Pharmacophore List

LigandScout allows one to screen a multitude of pharmacophores against multiple databases. Import

pharmacophores into the Pharmacophore List through the menu File > Open. Optionally, you can copy

them from other perspectives to the Screening Perspective by the Copyboard Widget. For the screening

process, make sure that at least one pharmacophore is selected and visible in the Pharmacophore List.

To remove a pharmacophore, select it and press the Delete Pharmacophore icon.

LigandScout provides the functionality to combine pharmacophores using boolean expressions (“AND”/

“OR”). If you select more than one pharmacophore, the pharmacophores are consecutively numbered.

Define the combination of your pharmacophores in the query text box under the Pharmacophore List.

Setting the pharmacophore numbers in brackets groups the expressions and ensures the order. The

boolean expression will be automatically checked due to its operability. A red spot shows an error in the

expression. The green spot signalizes that the expression is ready to use. For instance: “(3 AND 2) OR

1” means that a valid hit needs to be matched to pharmacophore 3 and 2, or only to pharmacophore 1.

If nothing is specified in the query text box, the selected pharmacophores are connected by the “OR”

expression.

3.5.2. Library View

After the screening process has finished, only the matched molecules (so called hit results) appear in

the Library View. Information such as, name, number of conformations, and geometric fit are shown per

molecule in the hit Library View table. In the Library View you can select the molecules one by one for

further investigation, filter or sort the table entries. You may also calculate additional properties for your

hit molecules by selecting the appropriate entry of the Library menu. For further information about the

navigation in the Library View, please see Section 3.1.5, “Library View”.
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Chapter 4. Introduction to
Pharmacophore Modeling
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This chapter provides general information about pharmacophore concepts.

1. Pharmacophore Modeling

2. Pharmacophore Feature Definitions

3. Editing a Pharmacophore Model

4.1. Pharmacophore Modeling

4.1.1. Pharmacophore Definition

What is a Pharmacophore?

A pharmacophore is defined as an ensemble of universal chemical features that characterizes a specific

mode of action of a ligand in the active site of the macromolecule in 3D space. Chemical features are,

e.g. hydrogen bonds, charge interactions and hydrophobic areas. This pharmacophoric pattern is the

condition for ligand-macromolecule interaction. Searching these chemical patterns in large molecule

databases allows you to find new scaffolds for developing lead structures.

3D Pharmacophore Models in LigandScout

LigandScout generates structure-based as well as ligand-based pharmacophore models. The advanced

3D pharmacophores supports multiple features per heavy atom to broaden the scope of a single model.

This approach enables you to have two hydrogen bond acceptors and one donor feature on the same
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atom. LigandScout's integrated in-silico screening considers these multiple features locations. However,

not all external in-silico screening applications support multiple features located on one heavy atom. If

you are using the software-packages Catalyst, MOE or Phase, it is recommended to use the Create

Simplified Pharmacophore routines.

4.2. Pharmacophore Feature Definitions
LigandScout provides the following pharmacophore features for automated pharmacophore generation:

Depiction in LigandScout Pharmacophore Feature

Hydrogen Bond Donor

Hydrogen Bond Acceptor

Positive Ionizable Area

Negative Ionizable Area

Hydrophobic Interactions

Aromatic Ring

Iron Binding Location

Zinc Binding Location

Magnesium Binding Location
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Depiction in LigandScout Pharmacophore Feature

Excluded Volume

While hydrogen bond features are defined by direction and distance constraints, hydrophobic interac-

tions and ionizable areas have a distance constraint only. Dedicated features are supplied for the char-

acterization of the binding of ligands to magnesium, zinc and iron. In addition to LigandScout's sup-

ported chemical features, the program increases selectivity of the generated pharmacophores with the

Excluded Volume Feature. During pharmacophore generation, LigandScout analyzes the shape of the

active site and places excluded volume spheres in positions that are sterically claimed by the macro-

molecular environment. This process ensures that molecules retrieved via virtual screening match the

sterical requirements of the active site while simultanously drastically increasing selectivity. Excluded

volume coats are likely to further increase enrichment.

4.2.1. Pharmacophore Feature Constraint Types

Pharmacophore features are defined by following constraints types:

Distance Constraints

Distance Constraints represent the relation between two points, one located on the ligand side, one on

the macromolecular side.

The following table shows LigandScout's default distance constraint settings:

Aromatic interaction with positive ionizable 3.5 - 5.5 Å

Aromatic interaction with ring (parallel) 2.8 - 4.5 Å

Aromatic interaction with ring (orthogonal) 2.8 - 4.5 Å

H-Bond interaction 2.2 - 3.8 Å

Hydrophobic interaction 1.0 - 5.9 Å

Iron binding location 1.3 - 3.5 Å

Magnesium binding location 1.5 - 3.8 Å

Negative ionizable interaction 1.5 - 5.5 Å

Positive ionizable interaction with negative ioniz-
able

1.5 - 5.5 Å

Positive ionizable interaction with aromatic ring 1.0 - 10.0 Å

Zinc binding location 1.0 - 4.0 Å
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Direction Constraints

Direction Constraints represent the relationship between two atom groups, one located on ligand side,

one on macromolecular side. Groups form a rigid reference geometry, which are the basis for a directed

vector.

4.2.2. Pharmacophore Feature Definitions

Hydrogen Bond Features

LigandScout discriminates flexible against rigid hydrogen bonds.

Rigid H-bond interactions, as occurring at sp2 hybridized heavy atoms, are represented by a cone with

cutoff apex. The default angle range for sp2 hybridized heavy atoms is 50 degrees. See Section 9.1.3,

“Hydrogen Bonding” for detailed instructions.

Figure 4.1. Rigid H-bonds constraint of an sp2 hybridized amide nitrogen.

Flexible H-bond interactions, as occurring at sp3 hybridized heavy atoms, are represented by a torus.

The default angle range for sp3 hybridized heavy atoms is 34 degrees. See Section 9.1.3, “Hydrogen

Bonding” for detailed instructions.
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Figure 4.2. Flexible H-bonding constraint of an sp3 hybridized hydroxy group.

Metal Binding Features (Magnesium, Zinc and Iron)

The maximum binding direction deviation for metal binding groups is 120 degrees; the respective binding

symmetry deviation is 0.75 Å.

Charge Interaction Features

Charge interactions are considered to be distance constraints and are depicted as an astral center in

LigandScout.

Hydrophobicity Features

Consistent with charge interaction features, also hydrophobicity features are regarded as distance con-

straints and are represented as a single sphere in LigandScout. Minimum thresholds and surface ac-

cessability thresholds are user-adaptable. See Section 9.1.5, “Hydrophobicity” for detailed instructions.
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Aromatic Features

Aromatic features represent pi-pi (orthogonal & parallel) and cation-pi interactions. LigandScout identi-

fies aromatic systems of the ligand that are interacting with aromatics or cations in the environment.

See Section 9.1.6, “Aromatic Interactions” for detailed instructions.

Excluded Volumes

Excluded volumes are derived from the sterical circumference of the macromolecule. LigandScout ana-

lyzes shape of the active site and places excluded volume spheres in positions that are sterically claimed

by the macromolecular environment. Excluded volumes spheres are represented as single spheres in

LigandScout. LigandScout's default settings are user-adaptable. See Section 9.1.2, “Distance Ranges”

for detailed instructions.

4.3. Editing a Pharmacophore Model

4.3.1. Create New Features and Change Feature Types

LigandScout provides three geometric types of features: vector (H-Bond Acceptor, H-Bond Donor, Iron

Binding Location, Magnesium Binding Location, Zinc Binding Location), point (Hydrophobic, Negative

Ionizable, Positive Ionizable, Exclusion Volume) and plane feature (Aromatic Ring).

You can create a vector feature between the ligand and the environment by selecting an atom on lig-

and-side and on environment-side. Then, choose your appropriate feature in the menu Pharmacophore

> Create New Feature. To create a feature only on the ligand-side, select at least one atom of the ligand.

If you want to create an aromatic ring feature, at least three atoms are needed to be selected. If you

choose more than one atom (ligand-side only), the new feature is created on the average position of the

selected atoms. To switch the type of a feature, select a feature and go to the menu Pharmacophore >

Change Feature Type. A submenu shows which types can be chosen.

4.3.2. Deleting Selected Features

LigandScout's automated pharmacophore generation algorithm is designed to create pharmacophores

and simplified pharmacophores that are well-suited for most applications. However, you may want to

manually delete features of a pharmacophore. Just select the features (spheres or vectors) in the 3D
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View and use the DEL key to erase the selected elements. The respective command Edit > Delete

Selected Elements and the Delete button provide the same functionality.

Overlapping hydrogen bond donor and acceptor features are depicted as half-green and half-red vec-

tors. Constistent with the respective feature type, LEFT mouse click on the green part selects the donor

and on the red part selects the acceptor.

4.3.3. Deleting All Features at Once

The Pharmacophore > Clear Pharmacophore command allows you to delete all pharmacophore features

at once. To reverse your actions use the Undo button or Edit > Undo command.

4.3.4. Increasing/Decreasing the Tolerance of Selected
Features

The Pharmacophore > Increase Selected Feature Tolerance by 0.15 Å and Decrease Selected Feature

Tolerance by 0.15 Å, respectively, allows you to adapt the tolerance spheres of selected features. The

commands allow one to adapt the selectivity of pharmacophore models smoothly to individual needs.

The tolerance spheres have high impact on the restrictivity of a model during virtual screening.

4.3.5. Edit Feature Weight

The commands in the menu Pharmacophore > Increase Selected Feature Weight by 0.1 and Decrease

Selected Feature Weight by 0.1 changes the weight of specific features. The feature weight has an

impact on the pair-wise alignment of pharmacophores. The value range is between 0 and 1, whereas

a feature weight near to 1 has more importance. The small sphere in the origin of a feature changes

its size according to the feature weight.

4.3.6. Marking Features

Mark Features as Optional flags the selected features which are not mandatory to find a valid alignment

(similar to the max. omitted feature action). During the screening process, a molecule is still a valid hit

when these marked features are not matched. Unmark Features as Optional  reverses the flag of the

selected features. To switch off features, select Mark Features as Disabled. These features are not taken

into account in the alignment process. To switch disabled features on, select Mark Features as Enabled.
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5.1. Structure-Based Pharmacophores

5.1.1. Why Use Structure-Based Pharmacophores?

Pharmacophores represent chemical functions, valid not only for the currently bound, but also unknown

molecules. Due to its simplicity, this method is computationally very efficient and is subsequently ex-

ceptionally well suited for virtual screening of large compound libraries. Pharmacophore modeling is

universal, comprehensive and editable: Selectivity-tuning by adding or omitting feature constraints pro-

vides a plenitude of manipulation options.

The following figures show the active site of CDK2 with ligand LS2 (PDB 1KE6) and the respective

pharmacophore model generated by LigandScout. The program automatically searches for interactions

between ligands and the macromolecule.
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Figure 5.1. Ligand LS2 of PDB entry 1KE6 in the active site

Figure 5.2. Structure-based pharmacophore model generated by LigandScout

In this example, LigandScout suggests an eight feature pharmacophore model consisting of three hy-

drophobic features (yellow spheres), two hydrogen bond donor features (green vectors) and three hy-

drogen bond acceptors (red vectors). This pharmacophore model represents a highly potent filter for

in-silico screening of new CDK2 ligands.

5.1.2. Basic Workflow

The basic workflow for structure-based pharmacophore model generation based on PDB complexes

consists of three main steps:

1. Extraction, identification, and interpretation of the ligand (hybridization states, bonds)
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2. Deduction of the pharmacophore

3. Visualization, user interaction, and export for virtual screening

5.2. Creating Structure-Based Pharma-
cophores

5.2.1. Data Import and Structure Preparation

For the automated generation of pharmacophore models, please import your favored PDB complex to

the Structure-Based Modeling Perspective in LigandScout. Since PDB data does not provide informa-

tion on atom hybridization states and bond types, LigandScout uses a sophisticated ligand interpretation

algorithm for the assignment of bond types via molecular geometry analysis. Data quality of PDB lig-

ands is known to be an issue in molecular modeling. Therefore, manual verification of the automatically

deduced ligand structure is highly recommended. Moreover, it represents a vital verification step for the

subsequent pharmacophore generation process. Special care should be taken on double bond types

and also on tautomerism. Tautomers are not discriminated by geometric analysis but have a decisive

impact e.g. on hydrogen bond features.

As you have imported and verified your macromolecule-ligand structure, you are ready to run

LigandScout's automated pharmacophore generation procedure. Please note that structure-based phar-

macophore generation is only available in Active Site View.

5.2.2. Automated Generation of Structure-Based Phar-
macophores

In Active Site View, simply press F9 on your keyboard to start the analysis. Alternatively, you may also

use the Create Pharmacophore button or through the menu Pharmacophore > Create Pharmacophore.

LigandScout will calculate the pharmacophore model within seconds.

LigandScout is designed for the retrieval of automatically created advanced 3D pharmacophore models

supporting multiple features per heavy atom to broaden the scope of a single model. However, not all

external in-silico screening applications support the wealth of pharmacophore feature handling which

is incorporated into LigandScout.

If you are using the software-packages Catalyst, MOE or Phase it is recommended to use the Create

Simplified Pharmacophore routines to achieve best compatibility to these external software applications.
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You may also edit advanced pharmacophores for analysis using Catalyst, MOE or Phase by manu-

ally deleting features. In this case, it is recommended to first delete features interacting with water

molecules and then to erase features that have unfavorable distances and angles. Try to obtain the

best feature(s) for every heavy atom. You can use literature to prioritize interactions. Tutorials on phar-

macophore preparation for Catalyst, MOE, and Phase provide more detailed information on this issue.

Please note that simplified pharmacophores are less restrictive and do not represent LigandScout's full

capacity of pharmacophore generation.

5.2.3. Creating Advanced Structure-Based Pharma-
cophore Models
LigandScout supports several additional pharmacophore generation modes. More detail is provided

here.

5.2.4. Creating Excluded Volumes Coat
LigandScout supports the generation of an excluded volume coat for structure-based pharmacophore

models via the menu Pharmacophore > Create Excluded Volumes Coat. Especially in the case of tight

binding pockets, this approach allows one to significantly enhance the selectivity of the model. However,

it is also well-suited for the simulation of binding cavities on the protein surface.

5.2.5. Creating Pharmacophore Models from Injected
Ligands
Ligands can be injected into different context: binding pocket, solely ligand or pharmacophore. In the

Active Site View you can add ligands from external sources by inserting a file containing molecules

by the menu File > Insert. The external ligands have to be in the correct coordinate frame to yield a

meaningful result. For instance, if the molecule to be injected was docked into the active site before,

this restriction will be fulfilled. If the coordinate frame was not correct, the inserted ligand will be placed

into the coordinate frame of the active site no matter if it makes sense or not.

In this way you can create pharmacophore models based on a certain docking pose for rapid virtual

screening of novel leads. Another application of this feature is the investigation of docking poses, since

it allows you to simply visualize the protein-ligand interactions of these conformers by generating the

pharmacophore model.

If the external ligands are not in the coordinate frame, you can align them into the context. For more

information on that, please see Section 3.1.5, “Library View” which enables you to navigate quickly

through large compound collections.
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LigandScout supports alignments of pharmacophores and molecules in arbitrary combinations. The

generation of shared feature pharmacophores is a powerful tool to combine the knowledge gained from

multiple pharmacophores.

1. Aligning Pharmacophores and Molecules

2. Shared Feature Pharmacophore Generation

3. Advanced Pharmacophore Editing: Merged Feature Pharmacophore Generation

6.1. Aligning Pharmacophores and Molecules

6.1.1. Aligning Pharmacophores and Molecules by
Features

General

LigandScout supports feature-based alignments of pharmacophores and molecules in arbitrary combi-

nations. Alignments are always performed pairwise no matter how many elements are to be aligned.

Therefore, it is necessary to mark one structure as a reference element. In case the user did not spec-

ify a reference element explicitly, LigandScout will automatically choose one element from the set of

selected elements. All other selected elements will be aligned to this reference element.

A single alignment is based on matched chemical features (feature pairs) where one feature must be the

reference element's feature set and the other must be from the feature set of the element to be aligned

to the reference element. For pharmacophores these chemical features are given explicitly. However,
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for molecules these features have to be derived during the alignment algorithm and for the sake of clarity

these are not visible to the user.

There are various ways to adjust the alignment algorithm. Please have a look at Section 9.5, “Alignment

Settings” for details. We refer to the Copyboard Widget for more information on how to add pharma-

cophores and molecules to the Alignment List. Possible interactions in the Alignment Perspective are

discussed in the Section 3.4.1, “Alignment Panel”.

Performing Alignments

Setting the Reference Element (Optional)

You can set a reference element prior to perform the alignment by selecting one element in the Alignment

List and clicking the Set Reference icon. Please note that setting a reference element is to be seen as a

hint to the alignment algorithm. If the reference element was set and the reference element is also part

of the selected elements to be aligned, this reference element will be used during alignment. In all other

cases (no reference element set, reference element set but not contained in the selected elements) an

arbitrary reference element will be chosen automatically.

Aligning Selected Elements

All elements which will be selected in the Alignment List will be aligned to a reference element. This

reference element can be set by the user or will be chosen automatically as described above. To perform

an alignment, select two or more elements in the Alignment List. This should look like the following

image where pharmacophores of ligands of complexes 1ke5 and 1ke6 were selected and 1ke6 was set

to be the reference element.

Figure 6.1. Before Alignment

After clicking the icon Align Selected Elements LigandScout will calculate one or several alignments

and present them to the user as illustrated in the image below. The activated slider indicates that there

are several alignments available. Information about each alignment are found in the Alignment Details
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View, e.g., the associated RMS (root mean squared) value of the valid matched feature deviances is

shown as well as the number of valid matched features.

Figure 6.2. After Alignment

There are cases where LigandScout will provide just a single alignment:

1. Three or more elements will be aligned to each other

2. A perfect alignment was found (usually a molecule to its own pharmacophore, or align-
ing two instances of the same structure)

6.1.2. Aligning Pharmacophores and Molecules by Ref-
erence Points

General

LigandScout supports alignments of pharmacophores and molecules with respect to the protein envi-

ronment. This is a useful feature to investigate protein-ligand complexes of structurally related targets

but also to generate shared feature pharmacophores. In this way the user is able to directly compare

the absolute position of one or several ligands within the aligned binding site. For this approach, the

investigated proteins structures have to show a certain degree of similarity, in order to achieve a mean-

ingful structural alignment.

Performing Alignments

First, check the Show Advanced Options Box in the Alignment Perspective. LigandScout now offers

both alignment modes: The Feature-Based Alignment mode and the Reference Points-Based Alignment
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mode. Activate the latter one and select the pharmacophore and/or molecules you want to align. Clicking

onto the icon Align Selected Elements calculates the aligment of these elements with respect to their

protein environment. In other words, LigandScout aligns the protein residues (which is by default not

visible in the Alignment Perspective) of all selected elements in order to overlay the pharmacophores

and molecules according to their position in the binding sites.

You can visualize the protein alignment by toggling on the reference points in the Hierarchy View or

select in the menu Render Control > Show Reference Points in the Alignment Perspective. The protein

residues will thereby be illustrated as small circles. In the same menu, Render Control > Show Reference

Point Names allows you to place the residue identifiers on these reference points. Show Reference

Point Tethers visualizes the affiliation of corresponding protein reference points with tethers.

6.2. Shared Feature Pharmacophore
The generation of shared feature pharmacophores is a powerful tool to combine the knowledge gained

from multiple pharmacophores. LigandScout creates a shared feature pharmacophore using a set of

selected elements and aligns them using the alignment algorithm. The resulting alignment of all selected

elements will be searched for valid feature overlappings. This means that one feature of a fixed element

is considered and all its valid matchings during the alignment. If this feature was validly matched by one

feature of each of the other elements these features are considered as a valid matched feature set. If

every feature lies within the tolerance of all the other features in this valid matched feature set, a new

feature will be derived by combining all the original features. The resulting feature consists of the mean

of all positions and the mean of all tolerances. This combination is done for every set of overlapping

features and results in a shared feature pharmacophore.

6.2.1. Creating a Shared Feature Pharmacophore

To perform a shared feature pharmacophore generation select two or more elements from the Align-

ment List and click on the icon Generate Shared Feature Pharmacophore. LigandScout will calculate

alignments and valid feature overlappings and will combine all valid feature overlappings into a shared

feature pharmacophore which will be presented after the algorithm has finished successfully.
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Figure 6.3. After Shared Feature Pharmacophore Generation

6.3. Merged Feature Pharmacophore
In case you would like to have more control over the generation of shared feature pharmacophores you

can use LigandScout´s ability to edit existing pharmacophores in the Alignment Panel. This includes

aligning pharmacophores and molecules by chemical features, merging these pharmacophores, and

interpolating their features to reduce overlaps. These editing functionalities can be either performed fully

automatically or manually.

6.3.1. Automatically Merge Pharmacophores

The fully automatic way to merge pharmacophores involves first aligning all of the selected elements,

merging all features into a single pharmacophore and interpolating features which overlap too much.

To perform this action select two or more elements from the Alignment List and click on the icon Gen-

erate Shared Feature Pharmacophore. LigandScout will then calculate several alignments. If there was

no valid alignment an error message will be displayed. Otherwise, LigandScout will choose the best

alignment and use it for merging the pharmacophores of the selected elements. Finally, features which

overlap too much will be combined into a single feature. After the algorithm has finished successfully,

the aligned, merged, and cleaned-up pharmacophore will be presented in the Alignment List and the

2D/3D Viewer.
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Figure 6.4. After merging pharmacophores

6.3.2. Manually Merge Pharmacophores

Align

You can use the automatic alignment as described in Aligning Pharmacophores and Molecules or you

can align several structures manually by selecting an element in the 3D Viewer, pressing Alt+Shift and

using LEFT or RIGHT mouse button to change positions of this selected element relative to the other

elements.

Merge Pharmacophores

Two or more pharmacophores can be merged by selecting two or more elements in the Alignment List

and pressing CTRL+ALT+M (Option+Command+M on MAC). The resulting pharmacophore will contain

a copy of every feature from the selected pharmacophores or the pharmacophores of the selected

molecules. The resulting pharmacophore can be cleaned up from overlaps automatically (see below).

Interpolate All Features Within Tolerance

Select one pharmacophore in the Alignment List and press CTRL+ALT+T (Option+Command+T on

MAC). This will trigger LigandScout to detect and group overlapping features automatically. Each group

of features will be replaced by the interpolated feature. So the resulting pharmacophore will contain

minimal overlap.
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Interpolate Features

You can also select features of the same type and from the same pharmacophore in the 3D Viewer

and have them interpolated by pressing CTRL+E (Command+E on MAC). Here, the restrictions are not

as tight as in the automatic way. You can select features within the range of five times the average

tolerance of the selected features. If all possible pairs formed from the selected features are within

this range this interpolation will be performed. The previously selected features will be replaced by the

interpolated ones.

6.3.3. Combine Features in One Pharmacophore

LigandScout supports the combination of all features of several aligned pharmacophores to one model.

This is useful, e.g., if there are two or protein-ligand complexes available and you want to combine the

interactions formed by these ligands. Use the Pharmacophore > Combine Features in One Pharma-

cophore  command to perform the automated combination of the currently selected pharmacophores.

In most cases you may want to downsize the number of features of the new model, especially, if there

are features of the same type adjacent to each other. Therefore, you can either use the Pharmacophore

> Interpolate All Features Within Tolerances command for a global merge, or you manually select the

features (of the same feature type) that you want to interpolate and use the Pharmacophore > Interpolate

Features command for manual merging (see above).
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7.1. Ligand-Based Pharmacophores

7.1.1. Why Use Ligand-Based Pharmacophores?

The ligand-based strategy deals with the absence of the macromolecule structure by deriving pharma-

cophore models from a set of ligands. This approach considers the conformational flexibility of the lig-

ands.

Similar small molecules provide similar biological activity. Thus, this approach searches for a common

feature pattern that is shared in an active ligand-set. The following figures show the ligands (LS2, LS3

and LS4) of 1ke6, 1ke7 and 1ke8 which bind to CDK2. LigandScout automatically creates the respective

pharmacophore to these ligands.
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Figure 7.1. The ligands LS2 (brown), LS3 (blue) and LS4 (pink) of the PDB entries 1ke6, 1ke7

and 1ke8

Figure 7.2. LigandScout's ligand-based pharmacophore model aligned with LS2, LS3 and LS4

In this case, LigandScout generates a ligand-based pharmacophore which is composed of two hy-

drophobic features (yellow spheres), two aromatic rings (grey elements), two hydrogen bond donor fea-

tures (green vectors) and two hydrogen bond acceptors (red vectors).

7.1.2. Basic Workflow

The workflow for ligand-based pharmacophore model generation based on a set of ligands is as follows:

1. Define and prepare Ligand-Set (Training-Set, Test-Set)

2. Ligand-based pharmacophore creation

3. Visualization, user interaction, and export for virtual screening



Ligand-Based Pharmacophore Design

71

7.2. Creating Ligand-Based Pharmacophores
Ligands which bind to one specific target protein, possess a similar binding mode. The goal of the lig-

and-based pharmacophore modeling is to seek common features in a set of ligands. LigandScout pro-

vides an automated generation of ligand-based pharmacophore models in the Ligand-Based Modeling

Perspective or command line.

7.2.1. Define and prepare Ligand-Set

A vast literature search of your target protein and its binding ligands are required. Although, if there are

no protein structures available, the information about essential amino acids for the binding mode gives

hints for verification of the results afterwards.

Define Ligand-Set

Gather known active ligands (at least 2) that bind to your target protein. This group of ligands serves

as a Training-Set for the main pharmacophore generation process. These molecules are overlapped

according to their pharmacophoric features and then several pharmacophore models are created that

are found in all Training-Set molecules. A similar feature scaffold is one indication for this group.

For instance, you can load in the Structure-Based Modeling Perspective 1ke6, 1ke7 and 1ke8 one by

one and add the ligands to the Ligand-Based Modeling Perspective by the Copyboard Widget. In case

you have an externally prepared ligands or Ligand-Set, just load it into the Ligand-Based Modeling Per-

spective by the menu File > Open or alternatively, use the Ligand-Set > Add Molecules: To Training-Set/

Test-Set.

Optionally, you can prepare a Test-Set, that includes actives and inactives. This set is used for the

verifying step, where the resulting pharmacophores are aligned to the Test-Set molecules. Ligands

which you do not want to include in the process, can be put to the Ignored Ligands set. The type of

the ligands can be changed through the menu Ligand-Set > Flag Molecule As or switching the type in

the Ligand-Set Table.

If you are not sure how to divide your ligands into Test-Set and Training-Set, then LigandScout's clus-

tering method assists your choice. The aim of this clustering is to choose those compounds that are

similar in terms of 3D pharmacophore characteristics and therefore bear a higher chance for delivering

a large overlap of chemical features. The 3D clustering algorithms performs fast alignments and clus-

ters based on a similarity value between 0 and 1. Since this algorithm basically performs combinatorial

alignments of all conformations of all compounds, a low number of conformations (1-3) is recommended.

The cluster distance can be varied until the desired cluster size has been reached. To use the clustering

method, select the Clustering icon. Adapt the settings for clustering and conformation generation (if no

conformers are available yet). Then, click the OK button to run the clustering process. A new column

Cluster ID appears in the Ligand-Set Table. The values show the group which the ligands are assigned

to. In the Ligand-Set Table, go through the ligands of each group to decide which type of set you want

to use for each ligand.
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Generate Conformations

To generate conformations for your ligands press the Generate Conformations for Ligand-Set icon. A

dialog appears where you can customize the settings. Alternatively, you can generate conformations

through the command line.

7.2.2. Performing Ligand-Based Pharmacophore Cre-
ation

Ligand-Based Pharmacophore Creation in LigandScout

When the ligand-set is ready to use for the pharmacophore generation, just press the Run Ligand-Based

Pharmacophore Creation icon. A settings dialog appears where you can adjust the properties for the

process.

To understand how the settings influence the pharmacophore creation, the process is explained shortly.

First, conformations of the Training-Set molecules are generated (if not available). After ranking the

molecules according to their number of conformations (flexibility), pharmacophore features (lipophilic

points, hydrogen bond donors and acceptors, positive and negative ionizable groups) are projected on

these molecules and all their conformations. All conformations of the two top ranked (i.e. the least flex-

ible) molecules are then aligned using Inte:Ligand’s molecular alignment algorithm. For a configurable

number of best alignment solutions (“intermediate alignment solutions”) common pharmacophoric fea-

tures are interpolated and intermediate pharmacophore models are created and stored for further pro-

cessing (“intermediate pharmacophore models”). These intermediate pharmacophore models are now

ranked using several adjustable scoring functions taking into account chemical feature overlap, steric

overlap, or both. The intermediate pharmacophore models are then aligned to all conformations of the

third molecule, etc., and a new set of intermediate combined feature pharmacophores is created until

all molecules have been processed. If at any stage no conformation can be found that can be matched

on any intermediate solution, the process is stopped. If at least three common chemical features can be

identified throughout the whole alignment and interpolation process, the feature pharmacophore com-

bination is considered to be successful. All these steps can be logged in a file verbosely. The output

can either be written in LigandScout’s internal file format (PML or PMZ) or e.g. in Catalyst/Discovery

Studio hypoedit format for use in Catalyst.

If the pharmacophore is exported to Catalyst, one must take into account that Catalyst is unable to map

two features on one single ligand atom - in this case the Catalyst hypothesis can be reduced by deleting

features or create several hypotheses for sequential virtual screening.

For forming intermediate solutions, two modes for sequential pairwise alignment are provided: shared

and merged feature pharmacophore combination mode. While with shared feature combination mode

an intersection between all pharmacophoric features of the underlying molecules is built (logical AND),

with merged feature pharmacophore building mode, the features of the aligned molecules will be merged

(logical OR). To avoid huge pharmacophores from merged feature pharmacophores, a parameter “num-

ber of omitted features” must be specified. This parameter defines how many features per molecule
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may be omitted by the algorithm with respect to the final pharmacophore solution. Specifying a value

of “1” for this parameter makes sure that a maximum of one feature is not matched by each of the

Training-Set molecules.

If you want to generate exclusion volumes to the ligand-based pharmacophore model, just toggle on the

Create Excluded Volume check box in the Ligand-Based Pharmacophore Creation dialog. To sterical

limit the pharmacophore, excluded volumes are placed around the best alignment model.

For more information about the settings, please see Section 9.2, “Ligand-Based Modeling Settings” and

Section A.6, “Scoring Function”.

7.2.3. Resulting Ligand-based Pharmacophore Models

After the ligand-based pharmacophore generation is finished, the results are listed in the Results Table.

Select the first result in the table. In the Hierarchy View make all ligands visible by selecting the Toggle

Visibility icon of each ligand. Thus, you can see how well the resulting pharmacophore fits to the ligands

in the 3D View. In the Ligand-Set Table the Feature Pattern column shows the color encoding of the

features, that matches the ligands. There, you can see which features cover the ligands well.
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Virtual Screening (also called in-silico screening) is a computational approach to select molecules with

desired properties in large molecule libraries. This technique is used to find new lead candidates in

the drug development process. Furthermore, it can reduce the assay-to-lead attrition rate, time and

expensive experiments during the process. LigandScout now allows you to in-silico screen molecule

libraries using 3D pharmacophore models as filter criteria. Furthermore, LigandScout pharmacophores

can be exported for virtual screening in other programs such as Catalyst, MOE and Phase.

8.1. Virtual Screening in LigandScout
Ligands with similar pharmacohoric patterns can exhibit similar biological activities according to one

specific protein. Thus, this chapter gives a few guide lines how to model a pharmacophore and find lig-

ands of a molecule library, that match to that specific pharmacophore. You can use the virtual screening

tool in LigandScout or through the command line.

8.1.1. Pharmacophore and Molecule Library Prepara-
tion

Create a pharmacophore model ( structure-based or ligand-based), according to a target protein, that

is capable to find a high amount of active ligands and as few as possible inactives. Here we refer a

structure-based pharmacophore of 1ke7 complex as an example. One of the essential steps is an ex-

haustive literature search about your protein of interest. Where does the ligand bind? Which amino

acids are required such that the ligand can interact with protein's binding pocket. Thus, this leads to the

knowledge about features that should be contained in the pharmacophore. Which ligands bind to the

protein and show biological activity and which do not? Load your protein-ligand complex in the Struc-

ture-Based Modeling Perspective, zoom into the active site, check the double bonds of the ligand and

create a pharmacophore. Check if the essential interactions are present and edit the pharmacophoric

features if required.
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It might be that several pdb complexes are available and therefore many pharmacophore models can

be generated. In the Alignment Perspective you can edit the pharmacophores, align them, generate a

shared or merged feature pharmacophore. Just add your pharmacophores and ligands one by one to

the Alignment Perspective and investigate them until you have created an appropriate pharmacophore.

See also Chapter 5, Structure-Based Pharmacophore Design, Chapter 6, Pharmacophore Alignment

and Chapter 7, Ligand-Based Pharmacophore Design for further information on pharmacophore cre-

ation.

LigandScout uses the proprietary LDB file format for storing molecule libraries which helps to efficiently

speed up the screening process. Hence, it is necessary to convert your molecule library into the LDB

file format before you load your library. For instance, if you open a SDF file in LigandScout, you can

export your library as a LDB file through File > Save as File. Alternatively, you can use the command

line tool idbgen to generate conformations and to convert your database into the LDB file format.

8.1.2. Run Virtual Screening

Add your pharmacophore model to the Screening Perspective, e.g., by the Copyboard Widget. Switch to

the Screening Perspective and load a molecule library (.ldb) by clicking the Load Database button. Then,

choose a pharmacophore. LigandScout offers you to select more than one database to be screened

against the selected pharmacophore. Select and mark the database containing active ligands in green.

If a decoy database is available that includes inactive ligands, mark it in red. To customize the advanced

screening settings, toggle on the Show Advanced Options Settings in the Screening Panel. Then, start

the screening process by pressing the Perform Screening button.

Optionally, you can screen a pharmacophore against an external database in the Structure-Based Mod-

eling Perspective. Make sure, that one pharmacophore is visible in the 3D View and select in the menu

Pharmacophore > Screen Pharmacophore Against External Library. A screening settings  dialog ap-

pears. Select your molecule database and modify the settings as required.

To execute the virtual screening process through the command line, please see Section A.5.3, “Virtual

Screening” in the Appendix.

8.1.3. Screening Results

When the screening process is finished, a hit list of molecules, that matches the pharmacophore is

shown in the Library View. Click the results one by one and look how the ligands are aligned to the

pharmacophore in the 3D View.

To see the ROC plot, press the Plot ROC Curve icon. The ROC curve shows how good the pharma-

cophore model discriminates between active and inactive ligands. The AUC value (area under the ROC

curve) quantifies the ROC curve between 0 and 1. A value near to 1 is favorable. If you want to export

the ROC plot as image, select in the menu File > Save as File. Choose an appropriate image file format
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(e.g. PNG) and enter a file name in the Save as dialog. Then, select the ROC check box plot of the

3D export properties.

If the screening results produce less active hits, there can be several reasons. Question yourself, if the

library ligands violate excluded volumes or is the pharmacophore too restrictive? Are the conformers of

the ligands meaningful? Are essential features found in the ligands? To get more hits, edit your phar-

macophore model. For instance, remove an excluded volume or other features or make the tolerance

sphere larger and screen again. Another way is to raise the number of maximum omitted features, e.g.,

1 or 2, depending on the size of the pharmacophore or designate some features as optional. To do

so, not all of the resulting ligand hits may contain all of the features of the pharmacophore model, but

again these can lead to interesting results. If you have the problem that too many hits are found, then

the model is too general and you should restrict your pharmacophore model. You can create excluded

volumes or an excluded volumes coat. An excluded volumes coat consists of many small excluded vol-

umes which reflect the spatial geometry of the binding pocket. Note that the combination of generalizing

and restricting the pharmacophore model is essential for influencing the hit results.

After all, finding a representative pharmacophore model of a ligand-protein binding mode needs a lot

validation. One approach is to include active and inactive ligands in the molecule library. If most of the

active ligands are contained in the hit results, then the pharmacophore covers the actives molecules

well. On the other hand, if inactive molecules are matched, then the pharmacophore might possess the

main feature scaffold matching the active ones; however pharmacophore model could not differentiate

between the active and inactive ligands. In this case you will need to build an improved model.

8.2. Preparing a Pharmacophore for Virtual
Screening with External Applications
LigandScout creates pharmacophore models that can be used in various external applications for virtual

screening. The following tutorials will show you how to prepare your pharmacophores to be used in

Catalyst, MOE, and Phase.

1. Preparing a Pharmacophore for Virtual Screening with Catalyst

2. Preparing a Pharmacophore for Virtual Screening with MOE

3. Preparing a Pharmacophore for Virtual Screening with Phase
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8.2.1. Preparing a Pharmacophore for Virtual Screen-
ing with Catalyst

Creating a Catalyst compatible Pharmacophore

LigandScout is designed for the retrieval of automatically created advanced 3D pharmacophore models

supporting multiple features per heavy atom to broaden the scope of a single model. However, not all

in-silico screening applications support multiple features located on one heavy atom.

If you are using the software-package Catalyst, it is recommended to use the Create Simplified Pharma-

cophore (Catalyst) routine. The process is started by pressing SHIFT+F9 or using the Create Simplified

Pharmacophore (Catalyst) command in the Pharmacophore menu. In this case, LigandScout achieves

compatibility by searching for the best feature for every heavy atom according to a feature priority. This

priority can be adjusted in the 'chemicalFeatureDefinitions.xml' file.

You may also reduce pharmacophores for Catalyst by manually deleting features. In this case, it is

recommended to first delete features interacting with water molecules and then to erase features that

have unfavorable distances and angles. Try to preserve the best feature for every heavy atom if there

are multiple features on one heavy atom. You may also use literature to sort out interactions.

Exporting and Converting Pharmacophores for Use in Catalyst

Open the Save dialog by selecting File > Save as File in the menu bar. Choose Pharmacophore as

Catalyst Hypoedit Script (*.hypoedit) in the file type drop-down menu, enter a file name and export the

pharmacophore. It is highly recommended to also export the ligand as MDL Mol file for later hypothesis

verification. Herewith, work in LigandScout is finished.

Next, the .hypoedit script has to be converted into a .chm hypothesis file, which can be imported into

Catalyst as a hypothesis ready to be used for virtual screening.

The following steps assume that you have properly installed Catalyst on your workstation. Since Lig-

andScout uses an extended dictionary, you have to provide this file, that is shipped with your Ligand-

Scout distribution, for the conversion step. As LigandScout sets the dictionary path in exported .hy-

poedit scripts to $CATALYST_DICTIONARY/Dictionary.chm  you either have to overwrite your

$CATALYST_DICTIONARY/Dictionary.chm with the LigandScout version or you use a text editor

to adapt the second row of the .hypoedit file (i.e. -dict $CATALYST_DICTIONARY/Dictionary.chm \ )

with respect to the location of LigandScout's Dictionary.chm version.

Now that all environmental needs are accomplished, use the command chmod a+x filename.hypoedit

to flag your script as executable. Run the script by typing ./filename.hypoedit . The script starts a short

conversion process resulting in a .chm file that you can import in Catalyst.

Importing a Hypothesis into Catalyst

Run Catalyst and import your .chm file by selecting in the menu Data > Import.
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Verifying the Hypothesis in Catalyst

It is highly recommended to verify Catalyst's fitting capability of this hypothesis with the respective ligand.

Only when Catalyst is able to fit ligand and hypothesis, can you be assured that Catalyst will find the

respective ligand in databases. Thus, please also import the ligand's MDL Mol file into your stockroom.

Drag & Drop both compounds into the Hypotheses Workbench. To open the Show Conformational

Model dialog, select in the menu Tools > Show Conformational Model. Select conf1 in the Conformers

Panel and click on Register Confs at the bottom of the window. Now that this conformer is registered,

return to your workbench and ensure that both ligand and hypothesis are still selected. To use the

Compare/Fit function, choose in the menu Tools > Compare/Fit. A new window will pop up on the left

side of your workbench offering several fitting options. For a first test, try to get a fitting with the defaults.

Catalyst will instantly depict a fitting in most cases. If you are unable to retrieve a fitting, please see the

guidelines and suggestions below for troubleshooting instructions. Otherwise, try to fit these compounds

with Max. Omitted Features set to '0'. This modification causes Catalyst to consider the fitting of every

single feature of the hypothesis. Fitting will only be successful, if all features can be fitted and only if

this fitting is successful, Catalyst will find this ligand by database search. In other words, if you want to

ensure that your ligand will be retrieved by Catalyst during a database search, you have to ensure that

Catalyst is able to fit this compound in the Hypotheses Workbench with Max. Omitted Features set to

'0'. The following list provides guidelines and suggestions on how to deal with the fitting issue.

Fitting Hypotheses in Catalyst: Guidelines and Suggestions

It may seem quite complicated to you to fit LigandScout hypotheses in Catalyst. However, with the

following suggestions you will be able to get fittings of highly selective pharmacophores the quick and

easy way!

1. Make sure that there are no multiple features on one heavy atom in the pharmacophore.
Catalyst does not support multiple features on the same position in 3D.

2. Set compare.minInterBlobDistance=0 in the .Catalyst parameters file to decrease the
overall minimum distance between features. Please see the Catalyst documentation for
detailed instructions on the .Catalyst parameters file

3. Set FunctionMapping.Hydrophobe.Neighbor.numBondLessEqualFromOWithDouble-
Bond=0 in the .Catalyst parameters file if you experience fitting problems of hydrophobic
features e.g. with sulfonamides.

4. Try to get a fitting with Max. Omitted Features set to '1' first, and only if this works, with
the parameter set to '0'

5. Locate the problematic pharmacophore feature(s): With Max. Omitted Features set to
'1', analyze the fitting. Fitted features with projection point (e.g. hydrogen bond features)
show a vector. This vector lacks in omitted features! In omitted spheres of all feature
types the central, small, light-blue sphere is missing! Excluded volumes are not problem-
atic for the fitting process and can be disregarded.

6. Hydrophobic features are most likely to be omitted by Catalyst's fitting algorithm. Special
care should be taken on methyl moieties and chains.

7. Watch out for very tight feature distances, e.g., at heterocyclic systems. These moieties
tend to have a lot of features focused in small space, which can be an issue.

8. In some cases, hydrogen bonds are only fitted after generation of a conformational mod-
el, because Catalyst is very restrictive on interaction angles. Generate conformers to
check if the features get fitted. However, it is recommended to adjust pharmacophores
to be fittable with the bioactive conformation of the PDB complex.
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9. Hydrogen bond feature fitting problems are most likely to occur at heterocyclic and steri-
cally hindered moieties.

10.Dismount the pharmacophore beginning with suspect features and always save interme-
diate steps as local object with Data > Save As Local Object.

11.Catalyst may deny fitting hydrogen bond features due to the location of its projected
points. Try to delete this sphere and the respective vector. Even without direction, these
features are valuable for highly selective pharmacophores.

Adding Features in Catalyst

In special cases you may want to add a feature to a pharmacophore within Catalyst.

Following guide shows you how to add features by using the Show Function Mapping feature, which

enables accurate placement of new features on heavy atoms of the PDB ligand.

1. Import ligand and hypothesis to your workbench and prepare the pharmacophore in a
way that Catalyst is able to achieve fitting with Max. Omitted Features set to '1'.

2. Add your favored feature (e.g. a hydrogen bond acceptor) to the desired heavy atom
with Catalyst's Show Function Mapping feature located in the Tools menu.

3. Use LigandScout to retrieve the coordinates, e.g., for the projected point of your hydro-
gen bond acceptor feature. Click the Toggle Tooltips icon of the LigandScout tool bar.
LigandScout shows you the exact position of the currently selected item in a box adja-
cent to your selection. These coordinates can be used to set the location constraints in
Catalyst.

4. Select the respective projected point of the hydrogen bond feature in your View Hy-
potheses workbench and alter the coordinates in the Set Constraint Tolerance dialog.
The Catalyst documentation gives you detailed information on how to add features to a
hypothesis.

8.2.2. Preparing a Pharmacophore for Virtual Screen-
ing with MOE

Creating a MOE compatible Pharmacophore

LigandScout is designed for the retrieval of automatically created advanced 3D pharmacophore models

to broaden the scope of a single model. However, not all in-silico screening applications support exactly

the same features or define their features in exactly the same way.

If you are using the software-package MOE, it is highly recommended to use the Create Simplified Phar-

macophore (MOE) routine. The process is started by pressing CTRL+SHIFT+F9 (Shift+Command+F9

on MAC) or selecting Pharmacophore > Create Simplified Pharmacophore (MOE) . In this case, Ligand-

Scout achieves compatibility by merging features at the same position and by adding charge features if

and only if one of the underlying atoms have an explicit charge. Also the hydrogen bond lengths have

to be adjusted to be 1.8 Å.
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Exporting and Converting Pharmacophores for Use in MOE

Open the Save as File dialog in the File menu. Choose Pharmacophore in CCG MOE Format (*.ph4) in

the file type drop-down menu, enter a file name and export the pharmacophore in one of the two sup-

ported MOE pharmacophore schemes. It is highly recommended to also export the ligand as MDL .mol

file for later hypothesis verification.

Importing a Hypothesis into MOE

Run MOE and import your .ph4 pharmacophore by selecting in the menu File > Open . Choose your

.ph4 file, select moe_ph4 in the drop-down box next to Force type and click OK.

Verifying the Hypothesis in MOE

It is recommended to verify the exported pharmacophore against its originating molecule in MOE. To do

this, you first create a database by selecting in the menu File > New > Database... . Enter a name for your

database and click OK. Now you need to import your previously exported MDL .mol file into the newly

created database. Select Import > SD from the File menu. This will open a new dialog. Click on Add...,

replace *.sdf by *.mol and press Enter. Select your previously exported .mol file and click OK. Also click

OK in the Import SD files dialog. Your molecule should now be in the database. However, a final step

is required to match LigandScout's features: Select Compute > Pharmacophores... and choose PHCD

in the drop-down menu next to Scheme. Click on OK and your database is all set.

Now, click on Search... in the Pharmacophore Query Editor. In the Open  dialog choose your newly

created database (*.mdb) and click OK. Click on Search and if everything worked out, you will see a

status message saying "1 molecule, 1 hit". Otherwise, at least one feature did not match and needs some

work. The check box Enable Partial Match in the Pharmacophore Query Editor allows you to find out

how many features did not match by iteratively decreasing the number of features which need to match.

8.2.3. Preparing a Pharmacophore for Virtual Screen-
ing with Phase

Creating a Phase 2.0 compatible Pharmacophore

LigandScout is designed for the retrieval of automatically created advanced 3D pharmacophore models

to broaden the scope of a single model. However, not all in-silico screening applications support exactly

the same features or define their features in exactly the same way.

If you are using the software-package Phase, it is recommended to use the Create Simplified Pharma-

cophore (Phase) routine. The process is started by pressing CTRL+SHIFT+F10 (Shift+Command+F10

on MAC) or using Pharmacophore > Create Simplified Pharmacophore (Phase) . In this case, Ligand-

Scout achieves compatibility by reducing multiple H-acceptor or donor features at the same ligand atom
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to a single feature of the respective type, and by implementing the hydrophobic feature perception al-

gorithm of Phase. Hydrogen bonding interactions are exported as point features to overcome the lack of

freely choosable bonding directions in combination with projected points and Phase's mandatory place-

ment of H-donor features at the position of hydrogen atoms.

You may also reduce pharmacophores for Phase by manually deleting features. In this case, it is rec-

ommended to first delete features interacting with water molecules and then to erase features that have

unfavorable distances and angles. Try to preserve the best feature for every heavy atom if there are mul-

tiple features of the same type on one heavy atom. You may also use literature to sort out interactions.

Exporting Pharmacophores for Use in Phase

Open the Save  dialog in the File menu. Choose Pharmacophore as Phase Files (*.xyz *.xvol *.def *.dxyz

*.mae) in the file type drop-down menu, enter a file name and export the pharmacophore. It is highly

recommended to also export the ligand in a format readable by Phase for later hypothesis verification.

Herewith, work in LigandScout is finished.

Importing a Hypothesis into Phase

Run Maestro and import your hypothesis .xyz file using the Hypotheses Table dialog reachable from

the Applications/Phase menu. Afterwards, you can see the pharmacophore and excluded volumes as

colored balls in the Maestro main window.

Verifying the Hypothesis in Phase

The following verification procedure assumes that the ligand structure has been exported from Lig-

andScout as ligand.sdf and the corresponding Phase hypothesis has been saved under the name

hypothesis.xyz. Furthermore, the hypothesis and ligand files have to be accessible from the current

working directory.

1. Create a Phase database containing only the ligand:
$SCHRODINGER/utilities/phasedb_manage -new sdf -db `pwd`/ligand_db -sd
ligand.sdf -confs true cp hypothesis.def ligand_db_feature.ini $SCHRODINGER/
utilities/phasedb_confsites -db `pwd`/ligand_db -JOB create_ligand_db

2. Try to match the hypothesis with the ligand molecule:
$SCHRODINGER/utilities/phasedb_findmatches -setup hypo_search -db `pwd`/
ligand_db -hypo `pwd`/hypothesis -mode find+fetch -deltaDist 2 -useExistingSites
true -useDbKeys false $SCHRODINGER/phase_dbsearch hypo_search

Successful execution of the above commands results in a search log-file called

hypo_search_dbsearch.log. Status messages near the bottom of the file should indicate a suc-

cessful overall search procedure and that 1 match to the hypothesis has been found in the database.
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Chapter 9. LigandScout Settings:
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LigandScout supports a plenitude of customizable settings. The Preferences can be accessed from the

Edit menu on Linux and Windows systems, and from the LigandScout menu on Mac OSX platforms,

respectively. This panel is composed of eight major settings areas:

1. Structure-Based Modeling Settings

2. Ligand-Based Modeling Settings

3. Chemistry Settings

4. Library Screening Settings

5. Alignment Settings

6. Rendering 3D and 2D Settings

7. Program and Network Settings

Every entry of the Preferences dialog exhibits a Default button and All Default button. The Default button

sets the current preference tab to their default settings (e.g. PDB interpretation tab). All Defaults sets

the whole Preferences dialog to factory defaults.
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9.1. Structure-Based Modeling Settings

9.1.1. PDB Interpretation

The PDB Interpretation Settings allows for adjusting ligand interpretation and customization of properties

of chemical features (distance ranges, hydrogen bonding, metal binding, hydrophobicity and aromatic

interactions) used in the pharmacophore generation.

Figure 9.1. PDB interpretation

PDB Interpretation Effect

Interaction cutoff
threshold

Defines a sphere surrounding each non-hydrogen atom of the lig-
and. All non-hydrogen atoms in the environment which are within
this sphere are considered as possible interaction partners during
the pharmacophore generation process. (default: 7.00 Å)

Planarity PCA thresh-
old

Defines the maximum out-of-plane deviation of parts of a molecule
to be considered planar. General sets the threshold for acyclic
molecule parts whereas Rings sets the threshold for cyclic molecule
parts. Higher PCA threshold increases the out-of-plane tolerance
resulting in an enhanced preference for sp3 hybridized atoms. (de-
fault: General: 0.250 Å; Rings: 0.220 Å)

Intra ligand limit Defines the maximum spacial distance between atoms of two
molecules to be considered as a single ligand. Increasing this limit
results in a preferred interpretation of two molecules to be seen as
one ligand. (default: 2.00 Å)

Update HET dictio-
nary

Updates the HET Dictionary from an online PDB resource. The
HET dictionary is used to enhance the PDB interpretation in case
the loaded data is incomplete (e.g. missing connect records, etc.)

Chemical Defaults Effect

Acids and cases If set true for the ligand or environment, the protonation states will
be adjusted automatically after downloading or opening PDB struc-
tures. In fact, all single-bonded oxygens of acidic moieties will be
deprotonated. For nitrogens which are double-bonded to two oxy-
gens, one of the double-bonds will be replaced by a single bond,
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Chemical Defaults Effect
the nitrogen's charge will be set to +1 and the oxygen will be depro-
tonated. (default: enabled)

9.1.2. Distance Ranges

Figure 9.2. Distance ranges settings

Feature Distance Effect

Feature-specific dis-
tance range

Defines the distance interval in which LigandScout considers hy-
drogen bonding by Hydrogen Bond Donor and Hydrogen Bond Ac-
ceptor features, hydrophobic interactions by Hydrophobic features,
charge interactions by Ionizable features, metal binding interactions
by Magnesium, Zinc, and IronBinding Locations, and aromatic inter-
actions by Aromatic Plane features.

Core Select the ligand-side feature for which the distance constraint
should be set.

Env Select the environment-side feature for which the distance con-
straint should be set. An interaction is only possible within the de-
fined distance range. The environment is the part of the macro-
molecule that surrounds the ligand.

Current distance
range

Shows the currently set distance range for the selected core-envi-
ronment feature pair.

Min Adjust the minimum distance range. (in Å)

Max Adjust the maximum distance range (in Å).

Set Range Sets the newly adjusted distance range for the selected core-envi-
ronment feature pair.

Steric Constraints Effect

Alpha C distance Set the minimum and maximum distance (such that an excluded
volume on an alpha carbon can be generated. If the alpha carbon
has interactions with ligand atoms closer than the maximum dis-
tance and no other feature is closer than the minimum distance,
then an excluded volume will be created on an alpha carbon. (de-
fault: Min: 2.0 Å; Max: 4.0 Å)

Alpha C exclusion tol-
erance

Sets the tolerance value which an excluded volume on an alpha
carbon will have. (default: 1.00 Å)
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9.1.3. Hydrogen Bonding

Figure 9.3. Chemical feature hydrogen bond settings

Angle ranges Effect

sp2 For an sp2 hydrogen bond donor atom. The angle between the vec-
tor (hbd atom, hydrogen) and vector (hydrogen, hba atom) must be
below this threshold to be a valid hydrogen bond. (default: 50.00°)

sp3 For an sp3 hydrogen bond donor atom. The angle between the vec-
tor (hbd atom, hydrogen) and vector (hydrogen, hba atom) must be
below this threshold to be a valid hydrogen bond. (default: 34.00°)

Acceptor Calculate the weighted vector from the hydrogen bond accecptor
atom to all of its neighbors. This mixed direction vector is inverted
and checked against the vector (hydrogen bond acceptor atom, hy-
drogen bond donor atom). This angle must be below the specified
threshold. (default: 85.00°)

9.1.4. Metal Binding

Figure 9.4. Chemical feature metal binding

Metal binding Effect

Maximum binding di-
rection deviation

Defines the maximum angle deviation from a ligating atoms idideal-
ized metal-binding axis. Lowering the value causes more restrictive
handling of preferred binding direction deviations. (default: 120.00°)

Maximum binding
symmetry deviation

Defines the maximum allowed relative binding length difference of a
metal atom to two or more ligating atoms. This setting is only effec-
tive in case of chelating moieties like hydroxamates. The lower the
value the more restrictive is the handling. (default: 0.75Å)
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9.1.5. Hydrophobicity

Figure 9.5. chemical feature hydrophobicity settings

Hydrophobicity Effect

Minimum thresholds Defines the minimum hydrophobic threshold of rings, chains and
groups to be considered as a hydrophobic moiety. Increasing the
minimum threshold causes more restrictive handling of hydropho-
bicity characteristics, resulting in pharmacophores containing less
hydrophobic features.

Surface accessibility
threshold

Defines the minimum sterical accessability threshold for moieties to
be considered as hydrophobic. The higher the threshold the more
restrictive the feature identification will be.

9.1.6. Aromatic Interactions

Figure 9.6. Chemical feature aromatic interaction settings

Aromatic Interac-
tions

Effect

Orthogonal center de-
viation

The minimum and maximum distance constraint two orthogonal
plane feature center points (one from the core and the other from
the environment) must meet. (default: Min: 0.0 Å; Max: 2.0 Å)

Parallel center devia-
tion

The minimum and maximum distance constraint two parallel plane
feature center points (one from the core and the other from the en-
vironment) must meet. (default: Min: 0.0 Å; Max: 2.0 Å)
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Aromatic Interac-
tions

Effect

Angle tolerance for
pi-cation interactions

The angle constraint that must be met for the angle between vec-
tor (plane center, ion position) and plane normal vector to be a valid
plane ion interaction feature. (default: 60.00°)

Angle tolerance for
pi-pi interactions

Orthogonal sets the maximum angle the two normal vectors for two
pi-pi orthogonal plane features may enclose to be a valid interac-
tion. Parallel sets the maximum angle the two normal vectors for
two Pi-Pi parallel plane features may enclose to be a valid interac-
tion. (default: orthogonal: 20.00°; parallel: 20.00°)

9.2. Ligand-Based Modeling Settings

9.2.1. Settings and Scoring

Figure 9.7. Settings and scoring

General Effect

Enable popup Enables/Disables the settings dialog popup for pharmacophore
generation, conformer generation and clustering. (default: enabled)

Ligand-Based Gen-
eration Settings

Effect

Pharmacophore
name

Sets the default name (prefix) for the resulting pharmacophores.
(default: Model)



LigandScout Settings: Preferences

88

Ligand-Based Gen-
eration Settings

Effect

Scoring function During the ligand-based pharmacophore generation all interme-
diate alignment results are scored according to the selected scor-
ing function. The pharmacophore fit scoring function only consid-
ers pharmacophoric features and the feature RMS deviation. The
relative pharmacophore fit scores the number of matching phar-
macophore features and the RMSD of the pharmacophore align-
ment normalized to [0..1]. If you want to consider steric properties,
you can choose the atom sphere overlap (fast shape) or Gaussian
shape similarity scoring functions. The first implements a fast atom
sphere counting algorithm to provide an overlap score. The latter,
uses Gaussian functions to approximate atom spheres. By doing so
the overlap can be calculated analytically. (default: Pharmacophore
fit and atom overlap)

Pharmacophore type Two different types of pharmacophoric models can be derived
due to different generation processes. The ligand-based pharma-
cophore generation is a pair-wise process. In each step one phar-
macophore for two molecules is drained. This we can do by either
taking all common features (Shared Feature Pharamacophore)
or by taking all features (Merged Feature Pharmacophore). In the
latter case each feature is scored and those are removed that do
not match all input molecules (see number of omitted features for
merged pharmacophore). The shared feature pharmacophore cre-
ates a pharmacophore that represents all common features of a lig-
and-set. If you want to take all features into account and assem-
ble them into one pharmacophore, then the merged feature phar-
macophore is your right choice. (default: Merged feature pharm-
cophore)

Number of omitted
features for merged
pharmacophore

This setting specifies the number of features that need not match all
input molecules if Merged feature pharmacophore type is turned on.
(default: 3)

Partially matching
features optional,
threshold (%)

If this threshold is exceeded, e.g. more than 20% of the molecules
do not match a feature, the feature is declared as optional, other-
wise it is handled like a normal feature. (default: 20)

Create exclusion vol-
umes

Excluded Volumes are generated. (default: enabled)

Apply custom feature
settings

Enables customized feature definitions. (default: disabled)

Feature tolerance
scale factor

This value is multiplied to the pre-defined feature tolerances. Low-
ering this scale factor would end up in more restrictive pharma-
cophoric models. (default: 1.0)

Max. number of
resulting pharma-
cophores

The maximum number of pharmacophores to be generated. (de-
fault: 10)

9.2.2. Conformer Generation

Customizing Conformation Settings allow you to tweak OMEGA settings.
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Figure 9.8. Conformer generation

Conformer Genera-
tion Settings

Effect

Max. num. conforma-
tions

Maximum number of conformations to output for each molecule.
Raising this value samples the conformational space better. (de-
fault: 25)

Timeout [sec] After this time, the conformer generation for a molecule is stopped
(and is considered to have failed!). If this occurs in the ligand-based
pharmacophore generation, the whole process automatically fails.
(default: 600 sec)

Max. search time The maximum time that is allowed for torsion search. (default: 30.0)

RMS threshold RMS threshold used to determine duplicate conformations. (default:
0.8)

Energy window Energy window used for conformer selection. (default: 10.0)

Max. num. generated
conformations

Maximum number of conformations to generate during the whole
process. (default: 30 000)

Max. pool size Maximum size of intermediate pool of conformers. (default: 4000)

OE license file The OMEGA license file to use (if left blank the built-in license is
used).

Enumerate rings If checked, ring conformers are enumerated. (default: enabled)

Enumerate nitrogens If checked, pyramidal invertible nitrogen geometries are enumerat-
ed. (default: enabled)

Replace unknown
atom types

If checked, atom types that are not supported by MMFF94 get re-
placed by closely supported analogues (e.g. Selenium by Sulfur).
(default: enabled)

Tautomer conforma-
tion generation mode

Sets the mode to generate tautomer conformation (Number of con-
formations distributed over tautomers or per tautomer. (default:
Num. confs. distributed over tautomers)

Apply FAST Settings Fast Settings are the settings for OMEGA which will result in a fast
generation of conformations but potentially of lower quality.
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Conformer Genera-
tion Settings

Effect

Apply BEST Settings Best Quality Settings are the settings which will result in longer pro-
cessing time but higher quality resulting conformations.

9.2.3. Clustering

Figure 9.9. Clustering settings

Settings Effect

Max. num. conforma-
tions

Defines the maximum number of conformations to take from the
pool of available ligand conformations. (default: 3)

Cluster sistance Defines the cluster distance. Low distances results in many clus-
ters. (default: 0.4)

Cluster distance cal-
culation method

Defines the type of cluster distances to calculate (Maximum, Mini-
mum or Average). (default: Average)

9.3. Chemistry Settings

9.3.1. Tautomerization

Tautomerization Settings allow for the customization of various parameters influencing ligand tautomer

enumeration and filtering.
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Figure 9.10. Tautomerization Settings

General Effect

Enable popup of tau-
tomer ceneration set-
tings dialog

Enables the settings dialog of the tautomer generation. (default: en-
abled)

Ignore topological
symmetry

If not checked, topologically identical ligand tautomers are discard-
ed even if they are different in 3D structure. (default: enabled)

Max. num. generated
tautomers

Specifies the maximum number of unfiltered tautomers to generate.
A value of 0 or -1 means no limit. (default: -1)

Max. num. output tau-
tomers

Specifies the maximum number of filtered output tautomers to gen-
erate. A value of 0 or -1 means no limit. (default: -1)

Tautomerization
Rules

Effect

Tautomerization
Rules

Allows you to enable/disable different kinds of common tautomeric
rearrangements. If all rules are disabled, no tautomers are generat-
ed.
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9.3.2. Tautomer Filters

Figure 9.11. Tautomer filters

Tautomer Filters Effect

Discard tautomers
with violated hy-
bridization geome-
tries

If checked, tautomers with atom hybridization states that require a
different spatial distribution of the neighbor atoms than the given
one are discarded (e.g. sp2 requires a trigonal planar arrangement
of the neighbors but the given arrangement is trigonal pyramidal).
The setting has only an effect if atom 3D coordinates are available.
(default: enabled)

Discard tautomers
with sp3 atoms in pla-
nar rings

If checked, tautomeric forms of a molecule with sp3 atoms in rings
that have been perceived as aromatic in the start tautomer are dis-
carded. (default: enabled)

Discard tautomers
with non-unique phar-
macophores

If checked, each generated tautomer with a molecule pharma-
cophore that is identical to a pharmacophore of a previous tau-
tomeric form is discarded. (default: disabled)

9.3.3. Force Field: MMFF94

MMFF94 and Minimization Settings allow for the customization of various parameters influencing

MMFF94 forcefield energy calculations and the conjugate gradients algorithm used for structure opti-

mization.
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Figure 9.12. Force field: MMFF94

Active Scheme Effect

Active Scheme Specifies the settings scheme depending on different cases. Bind-
ing pocket molecule energy minimization: If the molecule lies in the
active site. Free molecule energy minimization: the ligand without
environment. Library molecule energy calculation: calculates ener-
gies of molecules in a library. (default: free molecule energy mini-
mization)

Energy Contribu-
tions

Effect

Energy Contributions Specifies which types of forcefield interactions are considered and
contribute to the overall MMFF94 energy.

Angle bending If checked, angle bending interactions will contribute to the total en-
ergy. Otherwise angle bending is ignored. (default: enabled)

Bond stretching If checked, bond stretching interactions will contribute to the total
energy. Otherwise bond stretching is ignored. (default: enabled)

Out of plane If checked, out of plane bending interactions will contribute to the
total energy. Otherwise out of plane bending is ignored. (default:
enabled)

Stretch bending If checked, stretch bend interactions will contribute to the total en-
ergy. Otherwise stretch bend interactions are ignored. (default: en-
abled)

Electrostatic If checked, electrostatic interactions will contribute to the total ener-
gy. Otherwise Coulomb interactions are ignored. (default: enabled)

Van der Waals If checked, van der Waals interactions will contribute to the total en-
ergy. Otherwise van der Waals interactions are ignored. (default:
enabled)

Torsion If checked, torsion interactions will contribute to the total energy.
Otherwise torsion interactions are ignored. (default: enabled)

Parameters Effect

Distance cutoffs Allows the specification of distance cutoffs for van der Waals and
electrostatic interactions. A value of zero disables the interaction
distance cutoff.
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Parameters Effect

Van der Waals Defines the distance between two atoms up to which a van der
Waals interaction is considered to be present. (default: 12.0 Å)

Electrostatic Defines the distance between two atoms up to which an electrostat-
ic interaction is considered to be present. (default: 0.0 Å)

Electrostatic inter-
actions

Effect

Electrostatic interac-
tions

Definition of the distance exponent and dielectric constant used for
electrostatic interaction energy calculations.

Dielectric constant Specifies the dielectric constant to use for the calculation of
Coulomb interaction energy contributions. (default: 1.0)

Distance exponent Specifies the exponent of the interatomic distance in Coulomb inter-
action terms. (default: 2.0)

Parameter Set Effect

Active parameter set Specifies the parameter set to be used for calculation of MMFF94
energies. (default: MMFF94s enabled)

MMFF94 If selected, the 'dynamic' parameter set will be used.

MMFF94s If selected, the 'static' parameter set will be used.

9.3.4. Force Field: Minimization

Figure 9.13. Force field: minimization

General Effect

Optimize atoms on
editing

If selected, the edited atoms and bonds (type change, deletion, ad-
dition) are optimized automatically. (default: enabled)
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Active Scheme Effect

Active Scheme Specifies the settings scheme for energy minimization whether a
ligand is located in a binding site or is solely available. (default: free
molecule energy minimization)

Stopping Criteria Effect

Stopping criterion Selection of the optimization algorithm stopping criterion. (default:
RMS gradient)

Energy delta If selected, the tolerance value specifies a difference in energy be-
tween two optimization iterations. If the calculated energy difference
is lower than the specified delta, the optimization is stopped. (de-
fault: disabled)

RMS gradient If selected, the tolerance value specifies the root mean square of
the energy gradient components. If the calculated RMS gradient is
lower than the specified value, the optimization is stopped. (default:
enabled)

Tolerance Defines the value of the RMS gradient or energy delta (see above).
(default: 0.25)

Max. number of itera-
tions

Defines the maximum number of optimization iterations to perform.
A value of -1 specifies that the optimization is performed until the
rms gradient or energy delta is reached. (default: -1)

UpdateView If checked, the 3D View will be updated while performing the struc-
ture optimization. (default: enabled)

Fixed Atoms Effect

Fixed Atoms Definition of SMARTS patterns for the specification of atoms whose
position has to be kept fixed during a structure optimization run. In
a complex SMARTS pattern (two or more connected atom-patterns
matching a substructure) the atoms to keep fixed can be marked
by curly braces, e.g. O={C}-O. Otherwise all matched atoms will be
fixed.

Fixed ligand atoms A whitespace separated list of SMARTS patterns describing the lig-
and atoms to fix.

Fixed environment
atoms

A whitespace separated list of SMARTS patterns describing the en-
vironment atoms to fix. (default for binding pocket energy minimiza-
tion: * {[#1]}-[!O,!H2])
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9.4. Library Screening Settings

Figure 9.14. Library screening settings

Screening Settings Effect

Scoring function Choose the Scoring Function type that evaluates the alignments.
(default: pharmacophore fit)

Max. num. omitted
features

Defines the maximum number of features that can be omitted dur-
ing the screening. If zero is specified, the whole pharmacophore
must be matched to be a valid hit. (default: 0)

Stop after first match-
ing conformation

If checked, the screening for a molecule stops when the first
matched conformation is found. Note: this match is not the optimal
one. (default: enabled)

Check exclusion vol-
umes

Enables the consideration of exclusion volumes during the screen-
ing process. (default: enabled)

Enable popup of
screening settings di-
alog

Enables the settings dialog of the screening process. (default: en-
abled)

9.5. Alignment Settings
The Alignment Settings allow customizations for the alignment of arbitrary combinations of molecules

and/or pharmacophores. These settings are applied, depending on the active scheme.
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9.5.1. Alignment

Figure 9.15. Alignment settings

Alignment Effect

Active scheme Specifies the settings scheme for alignments in the screening pro-
cess, ligand-based model creation or Alignment Perspective. (de-
fault: virtual screening)

Maximum stored
alignments

Defines the maximum number of stored alignments. In case there
will be more alignments during the execution of the alignment al-
gorithm, only the best will be kept and the others will be discard-
ed. Note: The so called pharmacophore fit scoring function (con-
siders number of features and RMS) is used. The scoring function
can be customized only in the ligand-based settings to generate lig-
and-based pharmacophores. (default for Alignment Perspective and
ligand-based model creation: 20; Screening: 1 )

Discard alignments
threshold

Defines the maximum allowed RMS (root mean squared) deviation
of structures to be considered alignable. Alignments exceeding this
limit are rejected. The RMS calculation is based on valid matched
feature pairs of both structures. (default: 3.00 RMS)

Similarity threshold For every generated alignment a rotation is stored. Depending on
the deviation of the three unit vectors under this mapping an align-
ment will be discarded if it is too similar to a previous one. Certain-
ly, it will be checked which alignment has the better RMS value and
this one will be kept. (default: 5.0)

Maximum omitted
features

Defines how many features can be omitted during alignment. Align-
ments will be generated by combinatorially excluding the speci-
fied number of features. This means that the more features are left
out, the longer the generation process will take (NOTE: exponential
growth). (default: 1)
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Alignment Effect

Plane feature devia-
tion

Defines the maximum deviation of the normal vectors of two plane
features to be included in an alignment. If the angle between the
normal vectors exceeds the specified value, there will be no valid
match between these two plane features. (default: 25°)

9.6. Rendering Settings
The Renderer Settings allow users to predefine default render styles for the 3D Viewer.

9.6.1. 3D General Settings

Figure 9.16. 3D general settings

Default Settings Effect

Show reference
points

Toggles on/off the default visibility of the reference points in the
Alignment Perspective. If a pharmacophore or molecule is shown
for the first time then the visibility of reference points is assigned ac-
cording to this flag. (default: disabled)

Show exclusion vol-
umes

Toggles on/off the default visibility of the exclusion volumes in all
perspectives except the Structure-Based Modeling Perspective and
Bookmark View. If a pharmacophore is shown for the first time then
the visibility of exclusion volumes is assigned according to this flag.
(default: disabled)
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Default Settings Effect

Show active site box-
es on mouse-over

Enables/disables the Active Site boxes while moving the mouse
over a ligand in the Macromolecule View. (default: disabled)

Simple rendering
while moving

If turned on the render style is temporarily switched to line ren-
dering while user interaction (i.e. rotating or translating the visible
structure). This feature is especially designed for slower graphics
hardware. (default: disabled)

Lock colors of hetero
atoms

If enabled, the original colors of hetero atoms remain and cannot be
changed. (default: enabled)

Alignment Perspec-
tive

Effect

Use blur for focus
and context

The check box use Blur toggles between blurring and desaturated
coloring of ligands and pharmacophores. (default: disabled)

center added ele-
ments

The check box Center Elements toggles centering of the ligand or
of the pharmacophore while adding to the Alignment Panel. If en-
abled, the original coordinates are destroyed and the molecule or
pharmacophore is centered in the origin of the model coordinate
frame. This behavior can be undesirable if already aligned elements
are added from the Alignment Perspective to another view. If you
intend to add these elements back, e.g. to the binding pocket, the
original coordinates should be retained and this feature should be
turned off. (default: disabled)

Surface rendering Effect

Backface culling Enables/Disables the backface culling. If enabled all parts of a sur-
face not facing the viewer will not be rendered. (default: disabled)

Front clipping Enables/Disables the front clipping. If enabled then the surface area
closest to the point of view is not rendered. (default: disabled)

General Effect

Projection Switch between parallel and perspective projection. (default: per-
spective)

Projection angle Switch between normal and wide angle projection. The latter one
enhances perspective distortion. (default: normal)

Background color Switch between black and white background color scheme. (de-
fault: black)
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9.6.2. 3D Renderer Style

Figure 9.17. Renderer style

Default Rendering
Styles

Effect

Macromolecule View Defines the default render styles for macromolecule and ligand in
the Macromolecule View. (default: macromolecule: ribbon; ligand:
stick)

Active Site View Defines the default render styles for macromolecule and ligand in
the Active Site View. (default: macromolecule: snake; ligand: stick)

Alignment Perspec-
tive

Defines the default render styles for ligands and pharmacophores in
the  Alignment Perspective. (default: stick)

Rendering Settings Effect

Ball size scaling Defines a scaling factor which is applied to the ball size represent-
ing atoms. (default: 0.200)

Stick size scaling Defines a scaling factor which is applied to the stick size represent-
ing bonds. Depending on this factor the "aromatic ring" thickness is
adjusted too. (default: 0.600)

Surface Rendering
Settings

Effect

Surface transparency If switched on, you can see-through the generated surface. (default:
0.400)

Surface extent This function is only referred to the receptor binding pocket option.
The radius of every core atom is calculated whereas the nearest
environment atom according to a core atom is taken into account.
From that point on, the extent value determines the region (band
with) of environment atoms that are included in the calculation of
the surface. (default: 2.000 Å)
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Surface Rendering
Settings

Effect

Surface cutoff Defines the distance of every core atom to neighboring environment
atoms where the surface is cropped. A value of zero means that
the surface is cut by the first environment atom. Rising up this val-
ue determines the distance from that point. The surface cutoff is on-
ly used for receptor binding pockets. (default: 1.000 Å)

9.6.3. 2D Depiction

The 2D Depiction Settings allow one to adjust parameters for the 2D depiction of ligand structures.

Figure 9.18. 2D depiction

General Effect

Time limit for 2D cal-
culation

Defines the maximum calculation time for 2D structures. 2D struc-
ture calculation will stop at this limit even if no structure could be re-
trieved yet. (default: 15.00 sec)

Rendering Options Effect

Show hydrogens Specifies which hydrogens should be shown in the 2D depiction.
This can be either no hydrogens at all, hydrogens at hetero atoms
only, or all hydrogens. (default: show hydrogens for hetero atoms
only)

Features Toggles compact display of hydrogens. If selected the hydrogens
to be shown will be drawn as a label. Otherwise, hydrogens will be
drawn with a bond to their neighbor atoms. (default: enabled)
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9.7. Program and Network Settings
The Program and Network Settings allow to customize the direct web download of PDB structures.

9.7.1. Main Settings

Figure 9.19. Main settings

Application-wide
Settings

Effect

Central repository lo-
cation

Sets LigandScout's  Shared Repository path.

Undo levels Sets the number of actions LigandScout can Undo/Redo. The high-
er this number, the more memory will be required to store informa-
tion for  Undo/Redo. (default: 10)

9.7.2. PDB and Proxy
The PDB and Proxy Settings allow to customize the direct web download of PDB structures.

Figure 9.20. PDB and proxy
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Remote PDB Effect

Mirrors Manage your favorite mirror servers for PDB download (add, re-
move, reorder). The list of mirror servers is seen as a prioritized list
where the top most server is assigned the highest priority and sub-
sequently the bottom most server is assigned the lowest priority.
LigandScout will try to contact the servers and download the de-
sired files from them according to the servers' assigned priorities.

Remote Connection Effect

Proxy settings Allows for web access using a proxy server (which might be famil-
iar to you from your web browser settings). Please ask your system
administrator for access information via your proxy server.

Test proxy connec-
tion

This button allows you to test the connection to your proxy server.

Addresses of additional PDB servers can be obtained from http://www.rcsb.org/pdb/  [http://

www.rcsb.org/pdb/]or any other PDB mirror.

9.7.3. Distributed Calculation

Figure 9.21. Distributed calculation settings

Network Options Effect

Use iworkers If enabled LigandScout uses network iworkers to speed up the
screening process and the conformation generation. Please see
Section 2.5, “Networking”. (default: disabled)

Enable discovery If enabled, LigandScout tries to find iworkers in the network. (de-
fault: enabled)

Start local iworker If enabled, the local iworker is automatically started. (default: en-
abled)

iworkers Effect

iworkers Add or remove iworkers by adding or removing their network ad-
dresses. A network address has the form HOSTNAME:PORT or

http://www.rcsb.org/pdb/
http://www.rcsb.org/pdb/
http://www.rcsb.org/pdb/
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iworkers Effect
IP_ADDRESS:PORT. HOSTNAME or IP_ADDRESS is the host
name or ip-address of the iworker, and PORT is the TCP-port the
iworker is listening to. (Remember that the system administrator
has to open that port on the machine the iworker is running on!).
Examples:

• localhost:4283

• foo.bar:8729

• 192.168.0.34:5151

• 135.27.1.119:1894

Log Effect

Log If this option is used the logging of message traffic to and from this
node will be shown in the console or redirected to the specified file.
(default: console)

Level The level defines how much information of the log will be provided.
You can choose between off, low, medium, high and highest. Rais-
ing the level leads to a more detailed output. (default: off)
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A.1. LigandScout Menu Reference
LigandScout's menu bar consists of:

1. File

2. Edit

3. Library

4. Ligand-Set

5. Molecule

6. Pharmacophore

7. Align & Merge

8. Render Control

9. Surface

10.Window

11.Help

A.1.1. File

Open

Displays the Open File dialog (CTRL+O). Various file formats presenting chemical structure information

(e.g.: *.pdb, *.sdf, ...) can be imported to LigandScout. If you open new data, all current data is closed

before loading the new one.
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Insert

This command allows the injection of additional molecules into your shown data (binding site and/or

pharmacophore) in the Structure-Based Modeling Perspective (CTRL+I).

Save to Repository

Save to Repository  (CTRL+S) stores active sites and macromolecule information in your Local Repos-

itory.

Save as File

Save as File (CTRL+SHIFT+S) enables you to save/export your macromolecule and ligand modifica-

tions as well as your pharmacophore models. Depending on the file format, check boxes in the Save File

dialog let you choose advanced export settings and the items (ligand, environment, pharmacophore)

you want to save/export. The export settings are sensitive according to the current data (e.g.: if no phar-

macophore is present then related settings are disabled).

Close

Closes the shown data in the current view (CTRL+W). In the Structure-Based Modeling Perspective

LigandScout gives feedback and asks for confirmation, in case there is modified or unsaved data.

Sessions: Load Session from File

Loads the previously exported SES file which contains data of the Local Repository, Alignment Per-

spective, Ligand-Based Modeling Perspective and Bookmark View.

Sessions: Save Session as File

Stores the current data of the Local Repository, Alignment Perspective, Ligand-Based Modeling Per-

spective and Bookmark View in a single session file (SES file).

Sessions: Store current Session

Stores the current data of the Local Repository, Alignment Perspective, Ligand-Based Modeling Per-

spective and Bookmark View in a single session file. Selecting your named session reloads all the data

that was previously stored.

Sessions: Remove Session(s)

Deletes one of the available named session files from disk ( irrevocable operation).
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Repository: Delete from Local Repository

Deletes the current PDB complex from your Local Repository (CTRL+ALT+SHIFT+D). LigandScout will

reload the original data from the PDB server if requested.

Repository: Import Repository

Import Repository (CTRL+ALT+SHIFT+I) allows you to import a zipped PMZ database (*.zip) either

locally or to your default LigandScout data search path. The use of a PDB data repository drastically

accelerates the ligand-macromolecule complex initialization, since LigandScout uses the structural in-

formation stored in the repository instead of downloading the file from the PDB server and interpreting it.

Repository: Export Repository

Export Repository (CTRL+ALT+SHIFT+E) allows you to export a zipped PMZ database (*.zip) either

from the Local Repository or from your Shared Repository.

Repository: Clear Local Repository

Clear Local Repository (CTRL+ALT+SHIFT+C) erases the local PDB data storage.

Alignment: Import

Imports a previously exported set of alignments (CTRL+ALT+V). Using this functionality will directly

add all stored molecules and pharmacophores to the Alignment Perspective. In case the Alignment

Perspective already contains elements, a dialog will pop up and ask if the old elements should be deleted

before adding the new ones.

Alignment: Export

Export (CTRL+ALT+B) will export all molecules and pharmacophores which are currently listed in the

Alignment Perspective.

Print Preview

Print Preview (CTRL+ALT+P) shows the report that is printed with the Print command. Depending on

the current view, Print Preview will show either a 3D image of the macromolecule if the application is

in the Macromolecule View or it will show a report that will be printed with the Print command if the

application is in the Active Site View.

In the Macromolecule View the result will look like:
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Figure A.1. Print preview of macromolecule

In the Active Site View the report which will show up contains a 3D image of the active site, a 2D depiction

of the ligand as well as PDB complex meta data consisting of:

• PDB ligand key

• PDB complex ID

• Experimental type and resolution

• PDB classification

• Ligand name

• Deposition date

• Molecular formula

Here is an example of this report:
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Figure A.2. Print preview of active site

Print

Print (CTRL+P) enables you to print out the current complex as a report containing a 3D image of the

active site, a 2D depiction of the ligand as well as PDB complex meta data consisting of: PDB ligand

name, complex identifier, PDB classification, etc. LigandScout uses white background for printing.

If you want to export the 2D and 3D View of your shown elements as images, for instance molecule

alignments or single pharmacophore, select the Save command in the File menu. LigandScout supports

a various list of image file types such as PNG, POV etc. For more information please see Section 2.1.2,

“Exporting Files”

Restore Factory Defaults

Restore Factory Defaults (CTRL+SHIFT+F) will delete your Local Repository, alignment and bookmark

lists, dictionaries and preference settings. In fact it will delete everything which is contained in the folder

.inteligand-data  (the application's working directory).
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Recent Files

LigandScout journalizes the eight most recent files for fast and simple reaccess (CTRL+SHIFT+1...8).

Quit

Quits LigandScout application (CTRL+Q).

A.1.2. Edit

Undo

Undo (CTRL+Z) allows you to go back in history, reversing displays, selections and commands.

Redo

Redo (CTRL+Y) is the counterpart of the Undo command and executes your previously reversed action.

Select

Select: All (CTRL+A) picks all items (ligand, environment and pharmacophore) at once. The items can

be individually selected by choosing “Ligand”, “Environment” or “Pharmacophore”.

Clear Selection

Clear Selection cancels all selections.

Invert Selection

Invert Selection inverts the current selection, i. e. this command selects all elements without the currently

selected elements.

Delete Selected Elements

Delete Selected Elements (DEL) will delete all elements contained in the current selection.
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Preferences [Linux/Windows]

The Preferences (CTRL+SHIFT+P) allow you to customize LigandScout settings. This item can be

accessed via the LigandScout menu on Mac OSX platforms.

A.1.3. Library

Calculate Score to Shown Pharmacophore

Calculates the score between the shown pharmacophore and the ligands of the library. The pharma-

cophore score gives information about the fit between a pharmacophore and a molecule. This score

takes into account the number of matched features times 10 and the RMSD (Root Mean Square De-

viation).

Calculate Score to Shown Pharmacophore (Without Exclusion
Volumes)

Calculate Score to Shown Pharmacophore (Without Exclusion Volumes) calculates the score between

the shown pharmacophore and the ligands of the library. The exclusion volumes are not considered

in score calculation.

Align and Calculate Score to Shown Pharmacophore

Align and Calculate Score to Shown Pharmacophore first aligns the molecules of the library with the

shown pharmacophore. Then the score is calculated. The exclusion volumes are included in this score

calculation. If a ligand extends into any of the exclusion volumes the score is set to -1.

Align and Calculate Score to Shown Pharmacophore (Without Ex-
clusion Volumes)

Align and Calculate Score to Shown Pharmacophore (Without Exclusion Volumes) aligns first the

molecules of the library with the shown pharmacophore. Then the score is calculated. The exclusion

volumes are not included in the scoring process.

Calculate Standard Properties

Calculate Standard Properties calculates the standard properties of a molecule library. This includes

the calculation of Rel. TPSA, TPSA [P.Ertl], number of rotatable bonds, acceptors, rings, cLogP, MolWt,

heavy atoms and donors.
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Calculate Gaussian Shape Similarity Score

Calculate Gaussian Shape Similarity Score uses Gaussian functions for analytically overlap calcula-

tions.

Calculate MMFF94 Strain Energy

Calculate MMFF94 Strain Energy calculates the MMFF94 strain energy using the settings scheme "Li-

brary Molecule Energy Calculation".

Calculate MMFF94 Binding Energy

Calculate MMFF94 Binding Energy calculates the MMFF94 binding energy of the ligand to the environ-

ment.

Clear User Properties

Clear User Properties removes all user calculated properties of the library table.

Clear File Properties

Clear File Properties prevents the display of all library properties that are contained in a loaded file.

Close Library

Close Library closes the Library View.

A.1.4. Ligand-Set

Add Molecules

Add Molecules adds additional molecules to your Training-Set, Test-Set or set of Ignored Ligands.

Flag Selected Molecules

Flag Selected Molecules marks selected molecules as Training-Set, Test-Set or set of Ignored Ligands.

You can also decide, which molecules are active or inactive.
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Remove Selected Molecules

Remove Selected Molecules deletes selected molecules from the Ligand-Set.

Remove non-Espresso Properties

Remove non-Espresso Properties deletes external properties of the Ligand-Set, that are not generated

by Espresso.

Remove Pharmacophore Bias

Remove Pharmacophore Bias deletes the user-defined pharmacophore that influences the ligand-based

pharmacophore generation.

(Re)Create Conformational Models

(Re)Create Conformational Models creates conformations to your Ligand-Set. If conformations already

exist, they are recreated.

Cluster Ligand-Set

Cluster Ligand-Set clusters the Ligand-Set by pharmacophore based ligand similarity.

Create Pharmacophore

Create Pharmacophore automatically creates the pharmacophore, that is shared in the Training-Set

and matches it with the Test-Set. Conformations are automatically generated for the molecules if not

available.

Bias

Influences the Ligand-based pharmacophore generation according to pairwise alignment of pharma-

cophores in two ways. It can be influenced by a user-defined pharmacophore or customized feature

definition.
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A.1.5. Molecule

Re-Interpret Ligand

Re-Interpret Ligand (CTRL+R) causes LigandScout to re-interpret all bonds of the ligand shown in the

current Active Site View. This also triggers recalculation of properties like stereo chemistry, hydrogen

positions, and aromaticity.

Move Selection to Ligand Side

Move Selection to Ligand Side (CTRL+SHIFT+C) adds the selected environment elements to the ligand

side. LigandScout considers these elements as part of the ligand in pharmacophore generation. It is

also possible in the Macromolecule View to select some amino acids or nucleic acids and move them

to the core yielding new ligands instead of the acids bound to the macromolecule.

Move Selection to Macromolecule Side

Move Selection to Macromolecule Side (CTRL+SHIFT+E) adds the selected ligand elements to the

macromolecule side. LigandScout considers these elements as part of the environment in pharma-

cophore generation. This entry will only be active in Active Site View.

Create New Bond

Create New Bond (CTRL+SHIFT+B) adds a new bond between two selected atoms if it is reasonable.

Essentially this means that two atoms can be bound together if their distance is not too short and not

too long. This distance should be around the two atoms "normal" bonding distance.

Increase Charge of the Selected Elements

Increase Charge of the Selected Elements (+) adds a positive charge to the currently selected atoms.

Decrease Charge of the Selected Elements

Decrease Charge of the Selected Elements (-) adds a negative charge to the currently selected atoms.

Ionize Acids and Bases

Deprotonate all single-bonded oxygens of all acid-like substructures (CTRL+SHIFT+J). For nitrogens

which are double-bonded to two oxygens one of the double-bonds will be replaced by a single bond,

the nitrogen's charge will be set to +1 and the oxygen will be deprotonated. Basic amines, amidines,

and guanidines are protonated.
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Neutralize Acids and Bases

For all single-bonded deprotonated oxygens of acid-like substructures and all nitrogens which have a

double bond to an oxygen and a single bond to a deprotonated oxygen, the deprotonated oxygens will

be set back to a neutral state (protonated). Basic amines, amidines, and guanidines are neutralized

(CTRL+SHIFT+K).

Move All Water Molecules and Metals to Ligand Side

Move All Water Molecules and Metals to Ligand Side (CTRL+SHIFT+L) relocates all metals and water

molecules to the ligand side.

Move All Water Molecules and Metals to Macromolecule Side

Move All Water Molecules and Metals to Macromolecule Side (CTRL+SHIFT+M) relocates all metals

and water molecules to the macromolecule side.

Minimize MMFF94 Energy

Minimize MMFF94 Energy (CTRL+ALT+O) minimizes the MMFF94 energy of the ligand. For an un-

bound ligand the MMFF94 and optimization settings scheme “Free Molecule Energy Minimization” ap-

plies. For a ligand within a binding pocket the settings scheme “Binding Pocket Molecule Energy Min-

imization” is used.

Generate Tautomers

Generate Tautomers (CTRL+ALT+G) performs a tautomer enumeration of the shown ligand.

Show Tautomers As Library

Show Tautomers As Library shows the tautomers that are associated with the ligand in Library View.

A.1.6. Pharmacophore

Create new Feature

Create new Feature can create three geometric types of features: vector (H-Bond Acceptor, H-Bond

Donor, Iron Binding Location, Magnesium Binding Location, Zinc Binding Location), point (Hydropho-

bic, Negative Ionizable, Positive Ionizable, Exclusion Volume) and plane feature (Aromatic Ring). To

create a vector feature between the ligand and the environment, select an atom on ligand-side and
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on environment-side. Then, you can choose your appropriate feature. To create a feature only on the

ligand-side, select at least one atom of the ligand. To create an aromatic ring feature, at least three

atoms are needed to be selected. If you choose more than one atom (ligand-side only), the new feature

is created on the average position of the selected atoms.

Change Feature Type

Change Feature Type alters the type of a feature. Select a feature and change its type. A submenu

shows which types can be chosen.

Create Pharmacophore

Create Pharmacophore (CTRL+F9) activates LigandScout's automatic pharmacophore generation al-

gorithm. Both ligand and environment characteristics are analyzed for pharmacophore generation.

Create Simplified Pharmacophore (Catalyst)

Create Simplified Pharmacophore (Catalyst)  (SHIFT+F9) reduces advanced 3D pharmacophore mod-

els for  virtual screening with Catalyst. In case of multiple features on single atoms, LigandScout auto-

matically obtains the best feature for Catalyst.

Create Simplified Pharmacophore (MOE)

Create Simplified Pharmacophore (MOE) (CTRL+SHIFT+F9) reduces advanced 3D pharmacophore

models for  virtual screening with MOE. LigandScout will prepare the pharmacophore in a way which

works best for MOE.

Create Simplified Pharmacophore (Phase)

Create Simplified Pharmacophore (Phase) (CTRL+SHIFT+F10) reduces advanced 3D pharmacophore

models for virtual screening with Phase. LigandScout will prepare the pharmacophore in a way which

works best for Phase.

Clear Pharmacophore

Clear Pharmacophore (CTRL+ALT+ SHIFT+P) erases all pharmacophore features.

Create Exclusion Volume Coat

Create Exclusion Volumes Coat places individually adjusted exclusion spheres on the ligand surround-

ings occupied by protein residues. This feature allows one to simulate the binding site shape in order

to significantly increase enrichment during virtual screening.
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Create Exclusion Volumes on Selected Atoms

Create Exclusion Volumes on Selected Atoms places exclusion volumes on selected atoms.

Increase Selected Feature Tolerance by 0.15 Å

Increase Selected Feature Tolerance by 0.15 Å (CTRL+SHIFT+NumPad+) expands the tolerance

spheres of pharmacophoric features by 0.15 Å in order to decrease the restrictivity of the pharmacophore

model.

Decrease Selected Feature Tolerance by 0.15 Å

Decrease Selected Feature Tolerance by 0.15 Å (CTRL+SHIFT+NumPad-) narrows the tolerance

spheres of pharmacophoric features by 0.15 Å in order to increase the restrictivity of the pharmacophore

model.

Increase Selected Feature Weight by 0.1

Increase Selected Feature Weight by 0.1  rises the weight of a selected feature. The feature weight has

an impact on the pair-wise alignment of pharmacophores. (maximum: 1)

Decrease Selected Feature Weight by 0.1

Decrease Selected Feature Weight by 0.1  lowers the weight of a selected feature. The feature weight

has an impact on the pair-wise alignment of pharmacophores. (minimum: 0.1)

Interpolate Features

Interpolates selected features in the Alignment Perspective (CTRL+E). The features must be of the

same type and must belong to the same pharmacophore to yield a new chemical feature replacing the

selected old ones. Features will only be interpolated if their maximum pairwise distance will be lower

than five times the average tolerance of the selected features.

Mark Features as

Mark Features as Optional flags the selected features which are not mandatory to find a valid alignment

(similar to the max. omitted feature action). During the screening process, a molecule is still a valid hit

when these marked features are not matched. Unmark Features as Optional reverses the flag of the

selected features. To switch off features, select Mark Features as Disabled. These features are not taken

into account in the alignment process. To switch disabled features on, select Mark Features as Enabled.
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Screen Pharmacophore Against External Library

Use this functionality if you want to screen the current pharmacophore model against a molecule library

which is not loaded in LigandScout. The Open dialog appears where you can choose the library and

customize the settings for the screening procedure.

A.1.7. Align & Merge

Center Coordinates of All Structures

Centers all shown elements in Alignment Perspective (CTRL+ALT+C).

Set Reference

Sets the selected ligand or pharmacophore explicitly as reference for the alignment procedure in the

Alignment Perspective (CTRL+ALT+R).

Clear All Elements

Clear All Elements (CTRL+ALT+X) deletes all molecules and pharmacophores which are currently listed

in the Alignment Perspective. An confirmation pop up reconfirm your decision.

Align Selected Elements

Aligns the selected elements to the reference element (Align by features) or with respect to the protein

environment (Align by reference points) in the Alignment Perspective. Align by features allows one to

align both ligands and pharmacophore models by an algorithm examining the best possible pharma-

cophoric feature overlay. If no reference element was specified one of the selected elements will be

chosen randomly. Align by reference points is a useful tool to investigate protein-ligand complexes of

structurally related targets. It allows one to align the ligands with respect to the surrounding protein

residues. In this way the user is able to directly compare the absolute position of one or several ligands

within the aligned binding site.

Generate Shared Feature Pharmacophore

Allows one to generate shared feature pharmacophores based on feature alignment or reference points

alignment.
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Align & Merge Pharmacophores

Generates merged pharmacophores based on feature alignment or the alignment of reference points

of the selected pharmacophores and the pharmacophores of the selected molecules in the Alignment

Perspective. Every single chemical feature will be added (with its original positions) to a newly created

pharmacophore, the so-called merged pharmacophore.

Combine Features in One Pharmacophore

Joins all features of all selected pharmacophore models in one pharmacophore (CTRL+ALT+M).

Interpolate All Features Within Tolerances

In the Alignment Perspective this action will automatically group features of the same type which are

within their mutual tolerances (CTRL+ALT+T). Every group of features will be independently interpolated

yielding new features. These new features will replace the original groups of features in the resulting

pharmacophore. In other words, the resulting pharmacophore will not contain features with an overlap

of their tolerances that is too large.

A.1.8. Render Control

Ligand Default Style

The Ligand Default Style menu provides access to a variety of rendering modes, like Line, Ball and Stick,

Stick and Spacefilling/CPK. Hydrogens can be excluded from depiction or be reduced to stubs. Show

Templates activates the depiction of default geometric templates depending on the hybdridization-state

of the currently selected atom. Show Interactions displays all possible interaction partners within the

macromolecule of the currently selected ligand atom. Show Ionic Interactions displays ionic interactions

between metals and non-metals. The Pickable check box sets the ligand selectable/unselectable.

Environment Default Style

The Environment Default Style submenu of the Render Control menu corresponds in large part to the

respective ligand menu and lets you select different rendering modes and define hydrogen handling.

Show Templates activates the depiction of default geometric templates depending on the hybdridiza-

tion-state of the currently selected atom. The Pickable check box sets the environment selectable/uns-

electable in Active Site View.
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Selection

Selection lets you customize the rendering of the current selection. LigandScout provides four different

modes: Line, Ball and Stick, Stick and Spacefilling/CPK.

Protein Backbone Default Style

The Protein Backbone Default Style submenu lets you control the rendering of the protein backbone.

LigandScout provides four different modes: Lines, Splines, Snake, and Ribbon.

Pharmacophore

The Pharmacophore submenu enables you to switch on/off pharmacophore and excluded volume ren-

dering. The Pickable check box makes the pharmacophoric features selectable or unselectable in 3D.

Alignment Perspective Defaults

Use Blur (SDOF: Semantic Depth of Field) allows advanced blurring of objects. The effect is only visible if

the corresponding check box of ligands/pharmacophores in the Alignment Panel is activated. SDOF may

cause graphical issues or slow down the performance on low end computer systems and is therefore

recommended only with suitable hardware equipment. Show Reference Points allows to visualize the

position of the protein residues when using alignments based on reference points. Show Reference Point

Names places residue identifiers to this reference points. Show Feature Tethers visualizes the affiliation

of corresponding pharmacophoric features with tethers. Show Reference Point Tethers visualizes the

affiliation of corresponding protein reference points with tethers.

Behavior

The Behavior submenu gives you control on the main  3D View defaults. Pickable Bonds toggles the

possibility to select bonds. Highlight Bond Cylinders in Selection will only show an effect in the render

styles Ball and Stick and Line. If this option is disabled only the atom will be highlighted in Ball and Stick

render style and nothing will be highlighted in Line render style. However, if this option is enabled a

selected atom will also highlight all “outgoing” bonds half-way for both render styles. Simple Rendering

While Moving (CTRL+V) causes LigandScout to use less complex rendering algorithms while moving the

macromolecule-ligand complex. Show Tooltips shows you important information, such as classification,

geometry, and coordinates of your currently selected atom, bond, or pharmacophore feature. Enabled

option causes LigandScout to view a small information popup next to the selected object.

Projection

LigandScout supports parallel and perspective projection. Wide Angle View enhances perspective dis-

tortion. The Light Background option (CTRL+L) switches the 3D depiction to white background. Depth
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Cueing enhances depth recognition in the scene. AntiAliasing neutralizes stairway-effects at the edge

of rendered objects.

Center Camera on Ligand

Center Camera on Ligand (CTRL+Page Up) recenters the camera position on the ligand.

Center Camera on Binding Site

Center Camera on Binding Site (CTRL+Page Down) recenters the camera position on the protein bind-

ing site.

Turn Camera for Optimized View

Turn Camera for Optimized View recenters the camera position. This feature allows to quickly reposition

the protein-ligand complex with minimum overlap of the ligand atoms.

Add Angle Monitor

Allows one to measure the angle between three selected atoms. You can erase the angle monitor by

selecting the angle value and pressing the Delete icon.

Add Distance Monitor

Allows one to measure the distance between two selected atoms. You can erase the distance monitor

by selecting the distance value and pressing the Delete icon.

A.1.9.  Surface

None

No Surface will be displayed.

Ligand Van der Waals Surface

Depending on the van der Waals distances of ligand atoms spheres will be created and combined to

the van der Waals surface (CTRL+ALT+SHIFT+W).
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Ligand Solvent Accessible Surface

This surface describes the boundary which separates the ligand from its potential interacting atoms

(CTRL+ALT+SHIFT+S). This means, points on this surface are the closest locations, where interacting

atoms can appear.

Ligand Molecular Surface

This surface is created by placing a sphere around each ligand atom (CTRL+ALT+SHIFT+M). Then a

hypothetical probe is rolled over these spheres. The record of where this probe touched the spheres

will result in the molecular surface.

Receptor Binding Pocket

This will display the surface of all the atoms in the environment which potentially interact with ligand

atoms (CTRL+ALT+SHIFT+B). However, only those parts of the surface facing the ligand will be drawn.

Hide Back Side (Backface Culling)

This option will toggle the visibility of parts of the surface which will be seen from behind. This is espe-

cially useful for viewing a receptor surface, because this will allow you to cut away the front part of the

enclosing view and show the ligand as illlustrated below:

Figure A.3. Backface culling enabled (1HRV)
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Figure A.4. Backface culling disabled (1HRV)

Transparency (Alpha Blending)

Activating this option will result in a surface rendered transparently such that for example also the interior

of an enclosing surface will be visible.

Dynamically Update Surface

This option allows the fully automated recalculation of molecular surfaces upon molecule changes. The

prerequisite for this option to have an effect is that a molecular surface type other than “None” is selected.

Front Clipping

Front clipping suppresses the visualization of parts of the surface that may avert a direct view of the

ligand in the binding site. This feature is especially useful in the case of tight, elongated pockets.

Color Encoding

This menu item allows for coloring the surface. Available options are: No Color-Coding (Gray), By Atom

Type, By Polarity, By Aggregated Lipophilicity/Hydrophobicity and By MMFF94 Partial Charge.

• No Color-Coding (Gray) no specific coloring (defaults to gray).

• By Atom Type will use different colors for each atom type.

• By Polarity will color polar regions in red (hydrophilic areas).

• By Aggregated Lipophilicity/Hydrophobicity will color non-polar regions in yellow (hy-
drophobic areas).

• By MMFF94 Partial Charge will color by MMFF94 partial charge properties.
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Render Style

This menu item allows to choose between different render styles like solid, wireframe or rendering points.

Recalculate & Update Surface

If “Dynamically Update Surface” is disabled, this menu item allows to recalculate molecular surfaces on

request (CTRL+SHIFT+U). This may be needed if the core molecule was modified (e.g. changing of

atom types, moving parts to core or to environment, ...).

A.1.10. Window

PDB/Alignment/Bookmarks

Depending on the perspective you can enable/disable the PDB Control, Library/List, Alignment and

Bookmark Panels. The PDB Control Panel gives you information about the current PDB file and lets you

select a ligand in the Active Site View. The Library/List Panel shows molecules contained in a library.

The Alignment Panel allows you to align ligands and pharmacophores. In the Bookmarks Panel you

can save the current Active Site View.

2D Depiction

The 2D View Panel shows the 2D structure and pharmacophore of the currently selected ligand (Ligand

2D View). Important information and statistics are shown as Ligand Details View in Structure-Based

Modeling Perspective and Alignment Details View in Alignment Perspective. You can switch the 2D

View Panel on/off by using the keyboard shortcut CTRL+2.

Hierarchy View

The Hierarchy View (CTRL+T) gives a clearly arranged tree list of the currently visible elements (either

the whole macromolecule or the active site, ligands and pharmacophores). You can also toggle visibility

and colorize elements of the 3D View.

Library Table

The Library View allows to examine an external compound library of small organic molecules. It is

especially useful for the investigation of docking results in the Structure-Based Modeling Perspective.
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Ligand-Set Table

The Ligand-Set Table shows the ligands (Test-Set, Training-Set or Ignored Ligands) that are used for

the ligand-based pharmacophore generation in the Ligand-Based Modeling Perspective.

Screening Hits

The Screening Hits shows the hits of a screening run in the Screening Perspective.

3D Widgets

Enables/Disables several types of widgets to exchange and navigate through your data. The Copyboard

Widget transfers ligands, pharmacophores and active sites between perspectives. The Zoom Out Wid-

get switches from the Active Site View to the Macromolecule View. The Alternatives Switcher helps you

to go through your collection of selected compounds in the Library View. The Tautomer Switcher and

the Conformer Switcher guides you through the tautomers or conformers of a specific compound.

Show All Views and Tables

Show All Views and Tables (CTRL+SHIFT+A) enables all panels and control windows depending on the

current view (Ligand-Based Modeling Perspective, Structure-Based Modeling Perspective, Alignment

Perspective, Bookmark View or Screening Perspective).

Show 3D View Only

Show 3D View Only (CTRL+SHIFT+V) hides all other panels except 3D View.

A.1.11. Help

LigandScout Help

LigandScout Help (F1) starts the built-in help system. The chapters describes the functions that are

provided by LigandScout. You can also search specific terms in the Help dialog.

About this System

Displays information about this system's OpenGL implementation.
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About LigandScout [Linux/Windows]

Displays information about LigandScout and the development team. The corresponding entry is located

in the LigandScout menu on Mac OSX platforms.

License Information

Gives information about your LigandScout license.

A.2. LigandScout Icons Reference

A.2.1. Toolbar

Undo
 

Change Atom Type

Change Bond Type
 

Create New Bond

Re-Interpret Core Molecule
 

Increase Charge

Decrease Charge
 

Delete

Center Ligand Molecule
 Center Ligand and Environ-

ment

Move to Environment
 

Move to Core

Create Pharmacophore
 Toggle Exclusion Volume

Spheres Visibility

Change Render Style of Se-
lected Atoms

 
Toggle Hydrogen

Change Macromolecule Ren-
der Style

 
Toggle Tooltips

Add Angle Monitor
 

Add Distance Monitor
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Please note that not all icons will be displayed in case of too small screen width. Depending on their

importance the icons will be shown or not.

A.2.2. Hierarchy View

Collapse All
 

Link with Selection

Toggle Visibility
 

Change Color

A.2.3. Copyboard Widget

Copy current Ligand(s) to
 Copy current Pharmacophore

to

Copy current binding site to

A.2.4. Alignment Panel

Center All Visible Structures

 

Set Reference

Align Selected Elements
 Generate Shared Feature

Pharmacophore

Merge Pharmacophores and
Interpolate Overlapping Fea-
tures

 
Delete

Unselected
 

Selected

Context Representation
 

Focused Representation
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A.2.5. Bookmarks Panel

Delete Bookmark
 

Bookmark

A.2.6. Library View

Align Molecules on Injection
into the Binding Site

 
Hide All Compounds

A.2.7. Library: Alternatives Switcher

Show Previous Compound  Show Next Compound

Show All Compounds

A.2.8. Ligand-Based Modeling Perspective Toolbar

Generate Conformations for
Ligand-Set

 
Clustering

Run Ligand-Based Pharma-
cophore Creation

 
Stop

A.2.9. Screening Toolbar

Load Database
 

Perform Screening

Plot ROC Curve
 

Delete Pharmacophore
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A.2.10. Preferences Settings

Structure-Based
 

Ligand-Based

Chemistry
 

Screening

Alignment
 

Rendering

Program and Network

A.3. LigandScout Keyboard Shortcuts
Windows/Linux Mac OSX Function

CTRL+O Command+O open file

CTRL+I Command+I insert file

CTRL+S Command+S save to repository

CTRL+SHIFT+S Command+SHIFT+S save as file

CTRL+W Command+W close current data

CTRL+ALT+SHIFT+D Option+SHIFT+Co-
mand+D

delete from Local Repository

CTRL+ALT+SHIFT+I Option+SHIFT+Com-
mand+I

import repository

CTRL+ALT+SHIFT+E Option+SHIFT+Com-
mand+E

export repository

CTRL+ALT+SHIFT+C Option+SHIFT+Com-
mand+C

clear Local Repository

CTRL+ALT+V Option+Command+V import alignment

CTRL+ALT+B Option+Command+B export alignment

CTRL+ALT+P Option+Command+P print preview

CTRL+P Command+P print

CTRL+SHIFT+F SHIFT+Command+F restore factory defaults

CTRL+SHIFT+1...8 SHIFT+Com-
mand+1...8

open recent file

CTRL+Q Command+Q quit LigandScout

CTRL+Z Command+Z undo

CTRL+Y Command+Y redo

CTRL+A Command+A select all

DEL Function+Backspace delete selected elements
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Windows/Linux Mac OSX Function

CTRL+SHIFT+P Command+SHIFT+P open preferences dialog

CTRL+R Command+R re-interpret ligand

CTRL+SHIFT+C SHIFT+Command+C move selection to ligand side

CTRL+SHIFT+E SHIFT+Command+E move selection to macromolecule side

CTRL+SHIFT+B SHIFT+Command+B create new bond

+ + increase charge of selected elements

- - decrease charge of selected elements

CTRL+SHIFT+J SHIFT+Command+J ionize acids and bases

CTRL+SHIFT+K SHIFT+Command+K neutralize acids and bases

CTRL+SHIFT+L SHIFT+Command+L move all water molecules and metals to
ligand side

CTRL+SHIFT+M SHIFT+Command+M move all water molecules and metals to
macromolecule side

CTRL+ALT+O Option+Command+O minimize the MMFF94 energy of the lig-
and

CTRL+ALT+G Option+Command+G generate ligand tautomers

CTRL+F9 Command+F9 create pharmacophore

SHIFT+F9 SHIFT+F9 create simplified pharmacophore (Cata-
lyst)

CTRL+SHIFT+F9 SHIFT+Command+F9 create simplified pharmacophore (MOE)

CTRL+SHIFT+F10 SHIFT+Com-
mand+F10

create simplified pharmacophore (Phase)

CTRL+ALT+ SHIFT
+F9

Option+SHIFT+Com-
mand+F9

create hotspot pharmacophore

CTRL+ALT+ SHIFT+P Option+SHIFT+Com-
mand+P

clear pharmacophore

CTRL+SHIFT
+NumPad+

SHIFT+Command++ increase selected feature tolerance by
0.15A

CTRL+SHIFT
+NumPad-

SHIFT+Command+- increase selected feature tolerance by
0.15A

CTRL+ALT+C Option+Command+C center coordinates of all structures

CTRL+ALT+R Option+Command+R set reference

CTRL+ALT+X Option+Command+X clear all elements

CTRL+ALT+M Option+Command+M combine features in one pharmacophore

CTRL+ALT+T Option+Command+T interpolate all features within tolerances

CTRL+E Command+E interpolate features

CTRL+V Command+V simple rendering while moving

CTRL+L Command+L toggle background color (between black
and white)

CTRL+Page Up Command+Page Up center camera on ligand

CTRL+Page Down Command+Page
Down

center camera on binding site

CTRL+ALT+SHIFT+W  ligand van der waals surface

CTRL+ALT+SHIFT+S  ligand solvent accessible surface
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Windows/Linux Mac OSX Function

CTRL+ALT+SHIFT+M  ligand molecular surface

CTRL+ALT+SHIFT+B  surface of receptor binding pocket

CTRL+SHIFT+U SHIFT+Command+U recalculate & update surface

CTRL+2 Command+2 toggle 2D View

CTRL+T Command+T toggle Hierarchy View

CTRL+SHIFT+A SHIFT+Command+A show all views and tables

CTRL+SHIFT+V SHIFT+Command+V show 3D View only

F1 SHIFT+Command+H user manual, tutorials, examples

1, 2, 3 1, 2, 3 set the specified bond type to the select-
ed bond(s)

C, N, O, P, S C, N, O, P, S set the specified atom type to the select-
ed atom(s)

Cursor-LEFT Cursor-LEFT left rotation in 3D viewer

Cursor-RIGHT Cursor-RIGHT right rotation in 3D viewer

Cursor-UP Cursor-Up up rotation in 3D viewer

Cursor-DOWN Cursor-Down down rotation in 3D viewer

CTRL+Cursor-LEFT Command+Cur-
sor-LEFT

left rotation in 3D viewer by 90 degrees

CTRL+Cursor-RIGHT Command+Cur-
sor-RIGHT

right rotation in 3D viewer by 90 degrees

CTRL+Cursor-UP Command+Cursor-Up up rotation in 3D viewer by 90 degrees

CTRL+Cursor-DOWN Command+Cur-
sor-Down

down rotation in 3D viewer by 90 degrees

A.4. LigandScout Mouse Bindings

A.4.1. All Views and Panels

Mouse Button Activity Effect

LEFT click Select single element

LEFT double click Extend selection to whole element;
Macromolecule View : Select whole macro-
molecule;
Active Site View : Select whole ligand,
amino acid, or pharmacophore

SHIFT+LEFT press 2D and 3D View: Box selection Hierarchy
View, Select consecutive elements
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Mouse Button Activity Effect

CTRL+LEFT click Expand selection: Select individual elements

A.4.2. 3D View
Mouse Button Activity Effect

LEFT press Rotate

LEFT click Select single element

MIDDLE/WHEEL press or scroll Zoom in or out

RIGHT press Translate

A.4.3. 3D Alignment Perspective
For the following interactions it is assumed that at least one element was highlighted (yellow).

Mouse Button Activity Effect

ALT+SHIFT+LEFT press Rotate, but alter coordinates of the selected
elements

ALT+SHIFT
+RIGHT

press Translate, but alter coordinates of the select-
ed elements

A.5. Command Line Usage
The generation of conformations, ligand-based pharmacophores and the screening of molecule libraries

can be called from the command line. The executables are located in the LigandScout installation di-

rectory.

A.5.1. Conformation Generation
Usage:

idbgen [Mandatory arguments] [Optional arguments] [Distribution arguments]

Mandatory arguments:

--input, -i {infile} input file (*.sdf, *.smi, *.mol2, *.ldb)
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--output, -o {outfile} output file (*.ldb)

Optional arguments:

--help, -h {type} command line parameter help

   type: all lists all arguments

simple shows most important arguments

distribution shows network arguments

[param] displays detailed help for the argument '[param]'

--log-file, -l {logfile} output file for logging-messages (default: stdout)

--confgen-type, -t {type} confgen type (default: omega-fast)

   type: omega-fast omega high-throughput settings (25 confs)

omega-best omega high-quality settings (400 confs)

import import from input file

--multi-conf, -m auto-sense conformations in SDF files by name comparison (de-

fault: off)

--num-confs, -n {number} max. number of conformations to generate (default set by '--con-

fgentype' option)

--name-property, -p {prop-

name}

property for overriding molecule name

--omega-license, -z {file} omega license file (default: file specified by environment variable

OE_LICENSE)

--error-file, -e {file} file that collects molecules where errors occurred (default:

{OUTPUT_FILE}-failed.log)

--update-keep-old, -K update database and keep old entries

--update-drop-old, -R update database and drop old entries

--allow-duplicates, -A allow duplicates in the database (default: off)

--overwrite-existing, -O overwrite already existing molecules (default: off)

--num-processes, -b

{#processes}

number of processes to start (default: number of CPUs)

--exec-mode, -x {mode} the execution mode (default: multi)

   mode: single only one CPU is used

multi uses all CPUs/cores of this computer

network uses computers in the network

Distribution options:

--host-list-file, -H {file} host list file (default: ${HOME}/.inteligand-data/ligand-

scout3/iworker-list.txt)

--comma-sep-hosts, -c

{list}

comma separated host list (HOST1:PORT1,HOST2:PORT2,...)
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--network-interface, -N

{name}

network interface to use ('-n list' to list all available interfaces)

--verbosity, -v {loglevel} network logging verbosity (default: off)

   loglevel: off no network log messages

low network errors and warnings

medium connection info messages are shown

high high-level protocol messages

highest debug (very verbose)

A.5.2. Ligand-based Pharmacophore Generation

Usage:

espresso [Mandatory arguments] [Optional arguments]

Mandatory arguments:

--training-set, -t {filename} input file containing the training-set (*.sdf, *.mol2, *.ldb, *.smi)

Optional arguments:

--input, -i {filename} input file containing the training- and/or test-set (*.lsd)

--help, -h {helptype} command line parameter help

   helptype: all lists all arguments

simple shows most important arguments

[param] displays detailed help for the argument '[param]'

--quiet, -q suppress logging and info messages

--log-file, -l {logfile} output file for logging-messages (default: stdout)

--test-set, -s {file} input file containing the test-set (*.sdf, *.mol2, *.ldb, *.smi)

--pharmacophore, -p {file} output file containing the generated pharmacophore (*.pmz,

*.pml)

--output, -o {file} output file for ligand conformations that were used for pharma-

cophore generation (*.sdf, *.mol2, *.ldb, *.smi, *.lsd)

--confgen-type, -t {type} confgen type (default: omega-fast)

   type: omega-fast omega high-throughput settings (25 confs)

omega-best omega high-quality settings (400 confs)

import import from input file

--num-confs, -n {number} max. number of conformations to generate (default set by '--con-

fgentype' option)
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--omega-license, -z {file} omega license file (default: file specified by environment variable

OE_LICENSE)

--keep-confs, -y keep input conformations (default: override)

--enable-excluded-vol-

umes, -x

generate exclusion volumes from training-set

--pharmacophore-type, -g

{type}

the type of the pharmacophore to generate (default: merged)

   type: shared shared feature pharmacophore

merged merged feature pharmacophore

--scoring-function, -f

{score}

the function to use for scoring intermediate solutions and result-

ing pharmacophores (default: combo)

   score: pharma_fit scores the number of matching pharmacophore features and the

RMSD of the pharmacophore alignment

fast_shape scores the atom van der Waals sphere overlap of the aligned

training-set molecules

shape scores the molecular shape similarity of the aligned training-set

molecules based on a gauss function representation of the

molecular volume

combo scores the number of matching pharmacophore features, the

RMSD of the pharmacophore alignment and the atom van der

Waals sphere overlap of the aligned training-set molecules

--intermediate, -r {num-

ber}

the number of intermediate alignment solutions to use (default:

10)

--tolerance, -e {number} the global feature tolerance scaling factor (default: 1.0)

--merged-omit, -m {num-

ber}

max. omitted features for merged feature pharmacophores (de-

fault: 4)

--mark-optional-features,

-k

mark partially matching features as optional (default: disabled)

--optional-feature-t, -d

{number}

optional feature threshold (default: 10%)

--pharm-name-prefix, -u

{prefix}

name-prefix for resulting pharmacophore(s) (default: Model)

A.5.3. Virtual Screening
Usage:

iscreen [Mandatory arguments] [Optional arguments] [Distribution arguments]

Mandatory arguments:
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--query, -q {file} query pharmacophore (*.pmz,*.pml)

--database, -d {file} database to screen (*.ldb)

--output, -o {file} hit list (*.sdf)

Optional arguments:

--help, -h {type} command line parameter help

   type: all lists all arguments

simple shows most important arguments

distribution shows network arguments

[param] displays detailed help for the argument '[param]'

--log-file, -l {logfile} output file for logging-messages (default: stdout)

--disable-first-match-

mode, -s

all matching conformations are considered (default: only first

matching)

--disable-exclusion-vol-

umes, -e

disable checking for exclusion volume clashes

--allow-omit, -a maximum number of features to omit (default: 0)

--exec-mode, -x {mode} the execution mode (default: multi)

   mode: single only one CPU is used

multi uses all CPUs/cores of this computer

network uses computers in the network

Distribution options:

--host-list-file, -H {file} host list file (default: ${HOME}/.inteligand-data/ligand-

scout3/iworker-list.txt)

--comma-sep-hosts, -c

{list}

comma separated host list (HOST1:PORT1,HOST2:PORT2,...)

--network-interface, -N

{name}

network interface to use ('-n list' to list all available interfaces)

--verbosity, -v {loglevel} network logging verbosity (default: off)

   loglevel: off no network log messages

low network errors and warnings

medium connection info messages are shown

high high-level protocol messages

highest debug (very verbose)
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A.5.4. Networking: iworker

Usage:

iworker [Optional arguments]

Optional arguments:

--help, -h {helptype} command line parameter help

   helptype: all lists all arguments

simple shows most important arguments

[param] displays detailed help for the argument '[param]'

--log-file, -l {logfile} output file for logging-messages (default: stdout)

--auto-detection, -a enable auto-detection (default: off)

--max-parallel-tasks, -m

{NUMBER}

maximum number of parallel executed tasks (default: number of

CPUs)

--network-interface, -N

{name}

network interface to use ('-n list' to list all available interfaces)

--port, -p {NUMBER} tcp server port to use (default:30000)

--verbosity, -v {loglevel} network logging verbosity (default: off)

   loglevel: off no network log messages

low network errors and warnings

medium connection info messages are shown

high high-level protocol messages

highest debug (very verbose)

A.6. Scoring Function
LigandScout provides several scoring functions for ranking intermediate solutions during the lig-

and-based pharmacophore generation. All scoring functions were developed to deliver robust results

for several investigated targets. However, different scoring functions may deliver different results, de-

pending on whether shape (i.e., molecular volume) or chemical functionality is considered to be more

relevant for the assumed binding mode. Available scoring functions comprise Pharmacophore Fit (only

taking into account chemical feature overlap), Atom Overlap (“Fast Shape”), Gaussian Shape Similarity,

and a combination of Pharmacophore Fit and Atom Overlap. These scoring functions are described in

detail below.



Appendix

138

A.6.1. Simple Geometric Scoring Function (“Pharma-
cophore Fit”)

SFCR is the feature count/RMS distance score

SRMS is the matched feature pair RMS distance score in the range [0,9]

RMSFP is the RMS of the matched feature pair distances

NMFP is the number of geometrically matched feature pairs

c is a weighting factor for the number of matched feature pairs (currently

10.0)

A.6.2. Atom Sphere Overlap (“Fast Shape”)

SARO is the atom radius overlap score in the range [0,1]

n is total number of atoms of all involved molecules

Vimax is the maximum pseudo overlap volume of the ith atom with an atom of

another involved molecule and lies in the range [0,1]. For the overlap

volume to become non-zero, the atom has to overlap with at least one

atom from each other involved molecule

SARO is the atom radius overlap score in the range [0,1]

A.6.3. Gaussian shape similarity

SGSO is the gauss shape overlap similarity in the range [0,1]

VI is the common volume of intersection of all involved molecules

VSOi is volume of intersection of the ith molecule with itself
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A.6.4. Pharmacophore Fit and Atom Overlap

SDOF is the pharmacophore fit and atom overlap score

SMFC is the matched feature pair score

NMFP is the number of geometrically matched feature pairs

NF1 is the number of features in the first pharmacophore

NF2 is the number of features in the second pharmacophore

SFD is the matched feature pair distance score

di is the distance of the ith matched feature pair if the distance is greater

than 1, and zero otherwise

SRMS is the matched feature pair RMS distance score [0,1]

RMSmax is the maximum RMS to consider (set to 5.0)

RMSFP is the RMS of the matched feature pair distances

SARO is the atom radius overlap score in the range [0,1]

A.7. Primary Literature
Please visit our website for an up-to-date list of publications on LigandScout [http://www.inteligand.com/

ligandscout/pubs.shtml].

A.7.1. Primary reference describing methods and algo-
rithms

Wolber, G.; Langer, T.. LigandScout: 3-D Pharmacophores derived from protein-bound ligands and their

use as virtual screening filters J. Chem. Inf. Model.; 2005; 45(1); 160-169.

http://www.inteligand.com/ligandscout/pubs.shtml
http://www.inteligand.com/ligandscout/pubs.shtml
http://www.inteligand.com/ligandscout/pubs.shtml
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A.7.2. More information on pharmacophoric alignment
algorithm

Wolber, G.; Dornhofer, A. A.; Langer, T.; Efficient overlay of small organic molecules using 3D pharma-

cophores J. Comput. Aided Mol. Des.; 2007; 20(12); 773-788.

A.7.3. Applications

Lu, X. Y.; Chen, Y. D.; Jiang, Y. J.; You, Q. D.; Discovery of potential new InhA direct inhibitors based

on pharmacophore and 3D-QSAR analysis followed by in silico screening. Eur. J. Med. Chem.; 2009;

44(9); 3718-30.

De Luca, L.; Barreca, M. L.; Ferro, S.; Christ, F.; Iraci, N.; Gitto, R.; Monforte A. M.; Debyser Z.; Chimirri

A.; Pharmacophore-based discovery of small-molecule inhibitors of protein-protein interactions between

HIV-1 integrase and cellular cofactor LEDGF/p75. ChemMedChem; 2009; 4(8); 1311-6.

Ausiello, G.; Gherardini, P. F.; Gatti, E.; Incani, O.; Helmer-Citterich, M. Structural motifs recurring in

different folds recognize the same ligand fragments. BMC Bioinformatics; 2009; 10; 182.

Maccari, R.; Ottanà, R.; Ciurleo R.; Paoli, P.; Manao, G.; Camici, G.; Laggner, C.; Langer, T.; Struc-

ture-based optimization of benzoic acids as inhibitors of protein tyrosine phosphatase 1B and low molec-

ular weight protein tyrosine phosphatase. ChemMedChem; 2009; 4(6); 957-62.

Perdih A.; Bren, U.; Solmajer, T.; Binding free energy calculations of N-sulphonyl-glutamic acid inhibitors

of MurD ligase. J. Molec. Modeling; 2009; 15(8); 983-996.

Barreca, M. L.; De Luca, L.; Iraci, N.; Rao, A.; Ferro, S.; Maga, G.; Chimirri, A; Structure-based phar-

macophore identification of new chemical scaffolds as non-nucleoside reverse transcriptase inhibitors.

J. Chem. Inf. Model; 2007; 47(2); 557-562.

Steindl, T. M; Schuster, Laggner, C.; Chuang, K.; Hoffmann, R.; Langer, T.; Parallel screening and

activity profiling with HIV protease inhibitor pharmacophore models. J. Chem. Inf. Model; 2007; 47(2);

563-571.

Steindl, T. M; Schuster, D.; Wolber, G.; Laggner, C.; Langer, T.; High-throughput structure-based phar-

macophore modelling as a basis for successful parallel virtual screening J. Comput. Aided Mol. Des.;

2006; 20(12); 703-715.

Schuster, D.; Laggner, C.; Steindl, T. M.; Langer, T.; Development and validation of an in silico P450

profiler based on pharmacophore models. Curr. Drug Discov. Technol.; 2006; 3(1); 1-48.

Steindl, T. M; Schuster, D.; Laggner, C.; Langer, T.; Parallel screening: a novel concept in pharma-

cophore modeling and virtual screening. J. Chem. Inf. Model; 2006; 46(5); 2146-2157.

Krovat, E. M.; Fruhwirth, K. H.; Langer, T.; Pharmacophore identification, in silico screening, and virtual

library design for inhibitors of the Human Factor Xa. J. Chem. Inf. Model; 2005; 45(1); 146-159.
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A.7.4. Short Surveys

Rella, M.; A tool for automated structure-based 3D-pharmacophore generation and its application to

virtual screening. Monitor - in silico. Drug Discov. Today; 10(5):375. 2005

Dodd J.S.; Digital Briefs. Chemical & Engineering News, 83(39), September 26, 2005

A.7.5. Talks

Wolber, G.; Kirchmair J.; Structure-based 3D pharmacophores: An alternative to docking? Presentation

at the 7th International Conference on Chemical Structures in Noordwijkerhout, 2005

Wolber, G., Langer T.; Automated structure-based pharmacophore model generation, presentation at

the ACS Spring Meeting in San Diego, 2005
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